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Fonctions de diagnostic systéeme

Diagnostics for Windows

L utilitaire Diagnostics for Windows (DFW) permet de consulter

les informations concernant la configuration logicielle et matérielle
de I’ ordinateur exécutant Microsoft Windows XP. Il permet également
de réaliser des tests matériels et logiciels sur les sous-systémes

de I’ ordinateur.

Lorsque vous lancez Diagnostics pour Windows, 1’écran Présentation
apparait et vous indique la configuration actuelle de votre ordinateur.
A partir de I’écran Présentation, vous pouvez accéder a plusieurs
catégories d’informations sur I’ordinateur et a 1’onglet Test. Les
informations figurant dans chaque écran de 1’utilitaire peuvent €tre
enregistrées dans un fichier ou imprimées.

% Pour tester tous les sous-systémes, vous devez vous connecter en
tant qu’administrateur. Sinon, vous ne pourrez pas tester certains
sous-systemes. Le cas échéant, un message d’erreur apparaitra sous
le nom du sous-systeme dans la fenétre Test, ou certaines cases
grisées ne pourront étre sélectionnées.

Utilisez Diagnostics for Windows pour déterminer si tous les
périphériques installés sur I'ordinateur sont détectés par le systéme et
fonctionnent correctement. Bien que facultative, I'exécution des tests
est recommandée apres installation ou raccordement d'un nouveau
périphérique.

1l se peut que des périphériques de fabricants tiers non pris en charge
par HP ne soient pas détectés par Diagnostics for Windows.
Enregistrer, imprimer ou afficher les informations générées par
l'utilitaire. Avant tout appel téléphonique au centre d'assistance
technique, nous vous conseillons d'exécuter les tests et d'avoir un
rapport imprimé a portée de main.
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Fonctions de diagnostic systéme

Détection de Diagnostics for Windows

Sur certains ordinateurs, 1’utilitaire Diagnostics for Windows est chargé
sur le disque dur, mais n’est pas installé. Il se peut que vous I’ayez
déja installé en méme temps que d’autres utilitaires ou qu’il ait été
installé par un autre utilisateur.

Pour savoir si Diagnostics for Windows est installé :

1. Accédez a la fenétre contenant les icones de Diagnostics : Sous
Windows XP édition familiale ou professionnelle, cliquez sur
Démarrer > Panneau de configuration.

2. Parcourez les icones affichées dans le Panneau de configuration.

0 Si vous voyez des icones pour Configuration Record
et Diagnostics for Windows, I’ utilitaire Diagnostics
for Windows est installé.

O Sivous ne les voyez pas, I’utilitaire Diagnostics for Windows
est peut-étre chargé sur le disque dur, mais n’est pas installé.

Installation de Diagnostics for Windows

Si Diagnostics for Windows n’est pas présent sur le disque dur
de I’ordinateur, vous pouvez télécharger le SoftPaq correspondant
depuis le site :

www.hp.fr/support
L’ opération qui suit n’est nécessaire que si le programme de diagnostics
a été chargé sur le disque dur, mais qu’il n’est pas installé.

1. Fermez toutes les applications Windows.

2. Installez I’utilitaire Diagnostics for Windows :

a  Sous Windows XP, sélectionnez 1’icone Démarrer > Installation
du logiciel. Sélectionnez Diagnostics for Windows > Suivant
et suivez les instructions apparaissant a I’écran.

0 Sil’icone Installation du logiciel n’est pas présente sur
le Bureau ou dans le menu Démarrer, exécutez le programme
d’installation a partir du répertoire C:A\CPQAPPS\DIAGS ou
cliquez sur Démarrer > Exécuter et tapez la ligne de commande
suivante : C:\CPQAPPS\DIAGS\SETUP.

1-2
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3. Cliquez sur Suivant pour installer Diagnostics for Windows.

4. Une fois I'installation du programme terminée, il vous sera demandé
de redémarrer I’ ordinateur, ou celui-ci redémarrera automatiquement.
A T’invite, cliquez sur Terminé pour redémarrer 1’ ordinateur ou
sur Annuler pour quitter le programme. Vous devez redémarrer
I’ordinateur pour terminer I’installation de Diagnostics for Windows.

% Si vous désirez mettre a jour la version de Diagnostics for Windows
installée sur I’ordinateur, consultez le site www.hp.com/support pour
localiser la version la plus récente du SoftPaq correspondant
et le télécharger.

Utilisation de catégories dans Diagnostics for Windows

Pour utiliser les catégories, suivez les étapes suivantes :

1. Cliquez sur Démarrer > Centre d’informations HP > Diagnostics
for Windows. Vous pouvez également sélectionnez 1’icone
Diagnostics for Windows dans le panneau de configuration
en cliquant sur Démarrer > Panneau de configuration, puis
en sélectionnant Diagnostics for Windows.

L’écran affiche la présentation du matériel et des logiciels
installés sur 1’ ordinateur.

2. Pour obtenir des informations spécifiques sur un composant matériel
ou sur un logiciel, choisissez une catégorie a partir du menu déroulant
Catégories ou de I’icone correspondante dans la barre d’outils.

% Lorsque vous placez le pointeur de la souris sur les icones de la barre
d’outils, vous voyez apparaitre le nom des catégories.

3. Pour afficher des informations plus détaillées dans une catégorie
sélectionnée, cliquez sur Plus dans la zone Niveau d’information
dans le coin inférieur gauche de la fenétre ou cliquez sur Niveau
en haut de 1’écran et sélectionnez Plus.

4. Examinez, imprimez et/ou enregistrez les informations a votre guise.
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AN

Pour imprimer les informations, cliquez sur Fichier, puis sélectionnez
Imprimer. Sélectionnez ensuite I'une des options suivantes : Rapport
détaillé (toutes catégories), Rapport résumé (toutes catégories), ou
Catégorie en cours. Cliquez sur OK pour imprimer le compte-rendu
choisi.

Pour enregistrer les informations, cliquez sur Fichier, puis sélectionnez
Enregistrer sous. Sélectionnez ensuite I’une des options suivantes :
Rapport détaillé (toutes catégories), Rapport résumé (toutes
catégories), ou Catégorie en cours. Cliquez sur OK pour enregistrer
le compte-rendu choisi.

5. Pour quitter I'utilitaire de diagnostic, cliquez sur Fichier, puis
sur Quitter.

Barre de menu : Fichier, Catégories, Consultation, Niveau,

Tabulation, Aide

La partie supérieure de 1’écran de Diagnostics for Windows comporte
une barre de menu contenant six menus déroulants :

B Fichier : Enregistrer sous, Imprimer, Configuration de I’imprimante,
Quitter

B Catégories : La liste des catégories figure dans la section suivante

B Navigation : Catégorie précédente (F5), Catégorie suivante (F6)

B Niveau : Moins (F7), Suite (F8) <d’informations a 1’écran>

B Tabulation : Présentation, Test, Statut, Journal et Erreur

B Aide : Contenu, Comment utiliser I’Aide, A propos
Barre d’outils : Icones correspondant aux différentes catégories
d’informations

Sous la barre de menu, vous trouverez une rangée d’icones pour

chacune des catégories d’informations suivantes sur I’ordinateur.

B Systeme : carte mere, mémoire morte, date et heure

B Asset Control : étiquette des ressources, numéro de série

de I’ordinateur et informations sur le processeur

B Périphériques d’entrée : clavier, souris et manette(s) de jeu

B Communications : ports du systéme et informations sur chaque port
1-4 www.hp.com Manuel de résolution des problémes
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Unités de stockage : unités de stockage dans le systeme
et informations sur chaque unité

Carte graphique : informations systéme sur la carte graphique

Mémoire : informations sur la mémoire de la carte meére
et la mémoire Windows

Multimédia : stockage sur support optique (CD, DVD etc.)
et informations audio

Windows : informations sur Windows

Architecture : informations sur les périphériques PCI
Ressources : informations sur IRQ, E/S et I'image mémoire
Etat du PC : température du systéme et état des disques durs

Divers : CMOS, DMI, BIOS, systéme, nom du produit et numéro
de série

Tabulation : Présentation, Test, Statut, Journal et Erreur

Cinq onglets figurent sous la barre d’outils :

Présentation : la fenétre Présentation offre des informations générales
sur I’ordinateur. C’est la premiere fenétre qui s’affiche apres avoir
lancé I'utilitaire. Le volet gauche de la fenétre contient des
informations sur le matériel et le volet droit des informations

sur les logiciels.

Test : 1a fenétre Test vous permet de sélectionner les différentes
parties du systéme que vous souhaitez tester. Vous pouvez
également y sélectionner le type et le mode de test.

Statut : la fenétre Statut présente 1’état de chaque test en cours.
Vous pouvez annuler le test en cliquant sur le bouton Annuler
le test.

Journal : la fenétre Journal affiche un journal des tests pour chaque
périphérique.
Erreur : la fenétre Erreur affiche toutes les erreurs survenues lors

du test du périphérique. Cette fenétre contient le périphérique en
cours de test, le type et le nombre d’erreurs et le code d’erreur.
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Exécution de tests de diagnostics dans Diagnostics
for Windows

SN

Pour exécuter des tests de diagnostics :

1. Cliquez sur Démarrer > Centre d’informations HP > Diagnostics
for Windows. Vous pouvez également sélectionnez I’icone
Diagnostics for Windows dans le panneau de configuration
en cliquant sur Démarrer > Panneau de configuration, puis
en sélectionnant Diagnostics for Windows.

L’écran affiche la présentation du matériel et des logiciels installés
sur I’ordinateur. Vous trouverez cing onglets en dessous de la
rangée d’icones : Présentation, Test, Etat, Journal, et Erreur.

2. Cliquez sur I’onglet Test ou cliquez sur Tabulation en haut
de I’écran et sélectionnez Test.

3. Sélectionnez ensuite I’'une des options suivantes :

0 Rapide : exécute un test général rapide pour chaque
périphérique. Aucune intervention de I’utilisateur n’est
nécessaire si le mode Sans surveillance a été sélectionné.

0 Complet : effectue un test approfondi de chaque périphérique.
L utilisateur peut sélectionner le mode Interactif ou Sans
surveillance.

0 Test personnalisé : seuls sont effectués les tests que vous
sélectionnez. Pour sélectionner des périphériques ou des tests
particuliers, recherchez ce périphérique dans la liste, cliquez
sur la case placée a c6té des tests. Lorsqu’un périphérique
est sélectionné, une coche rouge apparait dans la case
correspondante. Certains des tests sélectionnés nécessiteront
une intervention de ’utilisateur.

Pour tester tous les sous-systemes, vous devez vous connecter en
tant qu’administrateur. Sinon, vous ne pourrez pas tester certains
sous-systemes. Le cas échéant, un message d’erreur apparaitra en
dessous du nom du sous-systeme dans la fenétre Test, ou des cases
grisées ne pourront pas étre sélectionnées.
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4. Choisissez Mode interactif ou Mode automatique. En Mode
interactif, le logiciel de diagnostic vous demande d’agir durant
un test. Certains tests se déroulent exclusivement en interactif
et affichent des messages d’erreurs ou s’interrompent lorsqu’ils
sont sélectionnés en combinaison avec le mode automatique.

0 Le mode interactif permet de maitriser enticrement le processus
de test. Vous pouvez déterminer si le test a réussi ou échoué
et vous pouvez étre invité a ajouter ou supprimer des
périphériques.

1 Le mode automatique n’affiche aucune invite. Les erreurs
éventuelles ne sont affichées qu’en fin de test.

5. Cliquez sur le bouton Début du test en bas de la fenétre. L’ état
du test s’affiche, indiquant la progression et le résultat de chaque
test. Pour plus de détails sur I’exécution de tests, cliquez sur
I’onglet Journal ou cliquez sur Tabulation en haut de I’écran
et sélectionnez Journal.

6. Pour afficher un compte-rendu des tests, sélectionnez un onglet :

0 L’onglet Statut résume les tests exécutés, réussis ou ayant
échoué au cours de la session.

O L’onglet Journal présente la liste des essais exécutés sur le
systeme, le nombre de répétitions du chaque test et les erreurs
détectées a chaque test, ainsi que la durée totale de chaque test.

O L’onglet Erreurs présente la liste des erreurs détectées
et le code d’erreur correspondant.

7. Pour enregistrer un rapport sur les tests :

0 Pour enregistrer le journal, sélectionnez I’onglet Journal,
puis cliquez sur Enregistrer.

0 Pour enregistrer un rapport d’erreurs, sélectionnez 1’onglet
Erreur, puis cliquez sur Enregistrer.

8. Pour imprimer un rapport sur les tests :

0  Si le rapport souhaité correspond a I’onglet Journal,
choisissez Fichier > Enregistrer sous, puis imprimez
le fichier enregistré dans le dossier de votre choix.

0  Sile rapport souhaité correspond a I’onglet Erreurs, sélectionnez
I’onglet Erreurs, puis cliquez sur le bouton Imprimer.
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9. En cas de détection d’erreurs, cliquez sur I’onglet Erreur pour
obtenir de plus amples informations et connaitre les mesures
a prendre. En suivant ces recommandations, vous pourrez peut
étre résoudre certains problemes vous-méme.

10. Cliquez sur Imprimer ou enregistrez les données d’erreur si vous
devez demander assistance a un revendeur ou mainteneur agréé.

11. Pour quitter I'utilitaire de diagnostics, cliquez sur Fichier, puis
sur Quitter.

Enregistrement de la configuration

L utilitaire Configuration Record (enregistrement de configuration)
est un outil de collecte d’informations similaire aux autres outils de
supervision. Il rassemble les informations importantes sur le matériel
et les logiciels, a partir de divers sous-systemes, pour offrir un apercu
complet de I’ordinateur. Il permet d’identifier et de comparer
automatiquement les modifications apportées a la configuration et peut
gérer I’historique de la configuration de 1’ordinateur. Les informations
peuvent étre enregistrées sous forme d’historique de multiples sessions.

Cet utilitaire a été réalisé pour permettre de résoudre les problemes

sans éteindre 1’ordinateur et d’optimiser ainsi la disponibilité de ce

dernier. Les informations qu’il fournit sont utiles pour la résolution

des problemes et rationalisent le processus de maintenance grice

a I’identification rapide des configurations de I’ordinateur, premiere
étape de la résolution des problémes.

L utilitaire Configuration Record rassemble automatiquement des
informations sur le matériel et le logiciel du systeme d’exploitation
en vue de fournir une vue d’ensemble du systeme. Il collecte et affiche
des informations sur des éléments tels que la mémoire morte, 1’étiquette
d’inventaire, le processeur, les lecteurs physiques, les périphériques
PCI, la mémoire, le moniteur, le numéro de version du systéme
d’exploitation, les parametres du systeme d’exploitation et les fichiers
de démarrage du systeme d’exploitation. Si le fichier Base.log d’origine
figure dans le répertoire cpgdiags, le fichier Base.log apparait a c6té
du fichier Now.log dans une fenétre séparée, les différences entre les
deux apparaissant en rouge.
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Installation de I'utilitaire Configuration Record

L utilitaire d’enregistrement de configuration fait partie de
Diagnostics for Windows. Il est installé lors de I’installation
de Diagnostics for Windows.

Exécution de I'utilitaire d’enregistrement de configuration

Pour exécuter ce programme :

1. Cliquez sur Démarrer > Centre d’informations HP >
Configuration Record. Vous pouvez également sélectionnez
I’icone Configuration Record dans le panneau de configuration
en cliquant sur Démarrer > Panneau de configuration, puis en
sélectionnant Configuration Record.

% L utilitaire d’enregistrement de configuration présente deux modes
d’affichage : Show Changed Items Only (N’afficher que les éléments
modifiés) et Show All (Tout afficher). Le mode d’affichage par défaut
est Show Changed Items Only. C’est la raison pour laquelle tout
le texte s’affiche en rouge puisqu’il ne présente que les différences.

Pour afficher une vue d’ensemble détaillée du systeme, sélectionnez
Show All.

2. Le mode d’affichage par défaut est Show Changed Items Only.
Pour afficher toutes les informations rassemblées par Configuration
Record, cliquez sur View (Affichage) en haut de la fenétre et
sélectionnez Show All ou cliquez sur I’icone Show All Items.

3. Pour enregistrer les informations contenues dans le volet droit
ou gauche, sélectionnez File (Fichier) > Save Window File
(Enregistrer le fichier de la fenétre), puis Left Window File
(Fichier de la fenétre de gauche) ou Right Window File
(Fichier de la fenétre de droite).

% L’enregistrement périodique de la configuration de I’ ordinateur permet
al’utilisateur de conserver un historique de la configuration. Ce dernier
pourra €tre utile a votre fournisseur de services en cas de panne de
I’ordinateur.

4. Pour quitter Configuration Record, cliquez sur Fichier, puis
sur Quitter.
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Protection des logiciels

Pour protéger vos logiciels contre toute perte ou détérioration, il est
conseillé d’effectuer une copie de sauvegarde des applications et logiciels
systeme, ainsi que des fichiers associés, stockés sur votre disque dur.
Reportez-vous a la documentation de votre systeme d’exploitation ou
de votre utilitaire de sauvegarde pour obtenir les instructions concernant
les copies de sauvegarde de vos fichiers de données.

Restauration des logiciels

Vous pouvez restaurer le systeme d’exploitation et les logiciels dans I’ état
ou ils se trouvaient au moment de I’achat de 1’ordinateur a I’aide CD
de restauration Restore Plus!. Pour de plus amples informations a ce
sujet, reportez-vous a la documentation fournies avec le CD Restore Plus!.
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Résolution des problemes
sans diagnostic

Ce chapitre fournit des informations sur I’identification et la résolution
de problemes mineurs au niveau des disques, de I’affichage, du systeme
audio, de la mémoire et des logiciels. Si vous rencontrez des problemes
au niveau de I’ordinateur, consultez les tableaux de ce chapitre pour
en connaitre les causes possibles et les solutions recommandées.

% Pour plus d’informations sur les messages d’erreur spécifiques
susceptibles d’apparaitre pendant I’autotest de mise sous tension (POST),
reportez-vous a I’ Annexe A, “Messages d’erreur du test POST.”

Sécurité et confort d’utilisation

AVERTISSEMENT : une utilisation inadéquate de votre ordinateur

ou un manque de sécurité et d’ergonomie de votre environnement de travail
peuvent étre source d’inconfort ou provoquer des lésions graves. Pour plus
d'informations sur le choix d’un espace de travail et sur I'aménagement
d’un environnement ergonomique, reportez-vous au guide Sécurité et
ergonomie du poste de travail sur le CD Documentation ou sur le site
www.hp.com/ergo.

Ce matériel a été testé et jugé conforme aux normes de la classe B concernant
les équipements numériques, selon I'article 15 de la réglementation FCC.
Pour plus d’informations & ce sujet, reportez-vous au document Informations
sur la sécurité et les réglementations sur le CD Documentation.
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Avant d’appeler I’assistance technique

Si vous rencontrez des problemes avec I’ ordinateur, essayez les solutions
ci-dessous pour déterminer exactement le probleéme avant d’appeler
I’ assistance technique.

Exécutez I'utilitaire Diagnostics for Windows. Pour plus
d’informations, reportez-vous a I’Chapitre 1, “Fonctions de
diagnostic systeme”.

Exécutez I’autotest DPS (Drive Protection System) de 1’ utilitaire
Computer Setup. Pour plus d’informations cet utilitaire,
consultez le Manuel de I'utilitaire Computer Setup (F10)

sur le CD Documentation.

Vérifiez si le voyant d’alimentation rouge clignote a I’avant de
I’ordinateur. Les clignotements sont des codes d’erreur qui vous
aident a diagnostiquer le probleme. Pour plus d’informations,
reportez-vous a I’ Annexe A, “Messages d’erreur du test POST”.

Si I’écran reste noir, branchez-le sur un autre connecteur vidéo de
I’ ordinateur, si ce dernier en posseéde un autre, ou utilisez un autre
écran dont vous avez la preuve qu’il fonctionne correctement.

Si vous travaillez en réseau, branchez un autre ordinateur avec
un cable différent sur la prise réseau. Le probleme peut étre causé
par un connecteur ou un cable réseau défectueux.

Si vous venez d’ajouter un nouveau matériel, retirez-le et vérifiez
si I’ordinateur fonctionne de nouveau correctement.

Si vous venez d’ajouter un nouveau logiciel, désinstallez-le et
vérifiez si I’ordinateur fonctionne de nouveau correctement.

Redémarrez I’ ordinateur en mode sans échec pour vérifier s’il peut
s’amorcer sans charger tous les drivers. Lors du chargement du
systeme d’exploitation, sélectionnez “Derniere bonne configuration.”

Consultez la documentation exhaustive en ligne a 1’adresse
www.hp.fr/support.

Reportez-vous a la section “Conseils” de ce manuel.
Exécuter le CD Restore Plus!

ATTENTION : |'exécution du CD de restauration Restore Plus! efface
toutes les données du disque dur.

2-2

www.hp.com Manuel de résolution des problémes


http://www.hp.com/support

Résolution des problemes sans diagnostic

Pour vous aider a résoudre vos problemes en ligne, 1’édition
professionnelle d’assistance instantanée HP vous fournit des
diagnostics de résolution par vous-méme. Si vous avez besoin de
contacter l'assistance technique HP, utilisez la fonction de
conversation en ligne de I'édition professionnelle d'assistance
instantanée HP. Vous pouvez accéder a cet outil a 1'adresse :
www.hp.com/go/ispe.

Consultez le centre d’assistance BSC (Business Support Center)
www.hp.com/go/bizsupport pour connaitre les derniéres informations
sur I’ assistance technique en ligne, les logiciels et drivers, la notification
proactive et la communauté mondiale d’utilisateurs et d’experts HP.

S’il s’avere indispensable d’appeler le service d’assistance technique,
au 0825 813 823 (0,15 € TTC/min), préparez-vous de la maniere
suivante

afin que votre appel puisse étre traité de fagon optimale :

B Soyez devant votre ordinateur lorsque vous appelez.

B Avant d’appeler, notez le numéro de série et le numéro de produit
de I’ordinateur, ainsi que le numéro de série du moniteur.

B Préparez-vous a passer le temps nécessaire a la résolution
du probléme en communication avec notre technicien.

B Retirez tout matériel que vous venez d’ajouter au systeéme.
B Désinstallez tout logiciel que vous venez d’installer.

B Exécutez le CD Restore Plus!

fi ATTENTION : |'exécution du CD de restauration Restore Plus! efface

toutes les données du disque dur.

%& Pour des informations commerciales ou les mises a niveau de la
garantie (Care Packs) appelez votre mainteneur agrée ou votre
représentant local.

Manvuel de résolution des probléemes www.hp.com 2-3


http://www.hp.com/go/ispe
http://www.hp.com/go/bizsupport

Résolution des problémes sans diagnostic

Conseils

Si vous rencontrez des problemes au niveau de I’ ordinateur, du moniteur
ou des logiciels, consultez la liste des suggestions ci-dessous avant de
prendre quelque mesure que ce soit.

Vérifiez que I’ordinateur et 1’écran sont branchés sur des prises
secteur en parfait état de marche.

Vérifiez que le sélecteur de tension est réglé sur la tension secteur
de votre pays (115 V ou 230 V).

Vérifiez que I’ordinateur est sous tension et que son voyant vert
d’alimentation est allumé.

Vérifiez que le moniteur est sous tension et que son voyant vert
d’alimentation est allumé.

Vérifiez si le voyant d’alimentation rouge clignote a I’avant de
I’ordinateur. Les clignotements sont des codes d’erreur qui vous
aident a diagnostiquer le probleme. Pour plus d’informations,
reportez-vous a I’ Annexe A, “Messages d’erreur du test POST”.

Si le moniteur est sombre, augmentez la luminosité et le contraste.

Appuyez sur une touche quelconque et maintenez-la enfoncée. Si
le systéme émet un signal sonore, le clavier fonctionne correctement.

Controlez toutes les connexions de cables et vérifiez qu’aucune
n’est lache ou incorrecte.

Désactivez I’état de veille en appuyant sur une touche quelconque
du clavier ou sur le bouton d’alimentation. Si I’état de veille

se maintient, arrétez 1’ordinateur en appuyant sur le bouton
d’alimentation et en le maintenant enfoncé pendant au moins quatre
secondes, puis appuyez de nouveau sur ce bouton pour redémarrer
I’ordinateur. Si le systéme ne s’arréte pas, débranchez le cordon
d’alimentation, attendez quelques secondes puis rebranchez-le.
L’ordinateur redémarrera si le démarrage automatique en cas de
coupure de courant est activé dans Computer Setup. Si I’ordinateur
ne redémarre pas, appuyez sur le bouton d’alimentation.
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Résolution des problemes sans diagnostic

B Apres 'installation d’une carte d’extension ou de toute autre option
non-Plug and Play, reconfigurez 1’ordinateur. Pour connaitre
la marche a suivre, reportez-vous a la section “Résolution des
problémes d’installation de matériel”.

B Assurez-vous que tous les gestionnaires de périphériques nécessaires
sont effectivement installés. Par exemple, pour utiliser une
imprimante, il vous faut un driver pour votre modele d’ imprimante.

B Retirez tous les supports amorgables (disquette, CD ou périphérique
USB) du systeme avant de le mettre sous tension.

B Si vous avez installé un systeme d’exploitation autre que celui
installé en usine, assurez-vous qu’il est pris en charge par
I’ordinateur.

B Si’ordinateur est équipé de plusieurs sources vidéo (carte PCI,
PCI-Express ou intégrée selon le modele d’ordinateur) et si vous
avez un seul écran, celui-ci doit étre connecté a la source vidéo
sélectionnée comme carte VGA principale. Les autres connecteurs
vidéo sont désactivés au démarrage ; 1’écran ne fonctionnera donc
pas s’il est connecté a I’un d’eux. Vous pouvez sélectionner la
source VGA par défaut dans Computer Setup.

fi ATTENTION : quand l'ordinateur est branché sur le secteur, la carte
mére est sous tension. Vous devez déconnecter le cordon d’alimentation
avant d’ouvrir |'ordinateur pour prévenir toute détérioration de la carte
systéme ou d’un composant.
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Résolution des problemes généraux

Vous devriez €tre en mesure de résoudre facilement les problemes
mineurs décrits dans cette section. Si un probléme persiste et si vous
vous sentez incapable de le résoudre vous-méme, contactez un
revendeur agréé.

Résolution des problémes généraux

Probléme

Cause

Solution

L'ordinateur semble
bloqué et ne s'éteint pas
quand vous appuyez sur

le bouton d’alimentation.

La commande logicielle
de l'interrupteur ne
fonctionne pas.

Appuyez sur le bouton d’alimentation
et maintenez-le enfoncé pendant

au moins 4 secondes jusqu’a ce

que 'ordinateur s'éteigne.

L'ordinateur ne répondra
pas au clavier ou & la
souris USB.

L'ordinateur est
en mode veille.

Appuyez sur le bouton d’alimentation
pour sortir du mode veille.

Le systéme est bloqué.

Redémarrez I'ordinateur.

A ATTENTION : si vous tentez de sortir du mode veille, maintenez enfoncé le bouton
d’alimentation pendant moins de quatre secondes. Sinon, |'ordinateur s’arrétera et vous

perdrez vos données.

L'affichage de la
date et de I’heure
de l'ordinateur est
incorrect.

La pile de I'horloge
temps réel (HTR) doit
éventuellement étre
remplacée.

Le fait de brancher
I'ordinateur sur une
prise secteur prolonge
la durée de vie de la

pile HTR.

Redéfinissez d'abord la date et |'heure
dans le Panneau de configuration
(vous pouvez également le faire avec
Computer Setup). Si le probléme
persiste, remplacez la pile HTR.
Reportez-vous au Manuel de référence
du matériel sur le CD Documentation
pour connaitre la procédure
d'installation d'une nouvelle pile

ou adressez-vous & votre revendeur
agréé pour effectuer le remplacement.

Le curseur ne se déplace
pas lorsque les touches
de direction du pavé

numérique sont utilisées.

La touche Verr num
est peut-étre enclenchée.

Appuyez sur la touche Verr num.
Si vous voulez utiliser les touches

de direction, le voyant Verr num

doit étre éteint. La touche Verr num
peut étre désactivée (ou activée) dans
Computer Setup.
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Résolution des problémes généraux (suite)

Probléme

Cause

Solution

Impossible de retirer
le capot ou le panneau

d’accés de I'ordinateur.

Le verrou Smart Cover,
disponible sur certains
ordinateurs, est activé.

Désactivez le verrou Smart Cover
via Computer Setup.

La clé Smart Cover FailSafe,
permettant de désactiver manuellement
le dispositif Smart Cover Lock, est
disponible auprés de HP. Vous aurez
besoin de cette clé si vous oubliez votre
mot de passe, en cas de coupure
d’alimentation ou de dysfonctionnement
de I'ordinateur. Utilisez la référence
de commande PN 166527-001 pour
la clé ou la référence PN 166527-002

pour |'embout de tournevis.

Vous observez de faibles
performances.

Le processeur est chaud.

1. Assurez-vous que |'arrivée d'air
de 'ordinateur n’est pas obstruée.

2. Assurez-vous que les ventilateurs
sont connectés et fonctionnent
correctement (certains ventilateurs
ne fonctionnement que si cela est
nécessaire).

3. Assurez-vous que le dissipateur
thermique du processeur est
installé correctement.

Le disque dur est plein.

Libérez de I'espace sur votre disque
dur en transférant des données sur
un autre disque.

Manque de mémoire.

Ajoutez de la mémoire.

Disque du fragmenté.

Défragmentez le disque dur.

Les programmes
récemment utilisés n’ont
pas libéré la mémoire
qui leur a été attribuée.

Redémarrez 'ordinateur.

Virus résident sur
le disque dur.

Exécutez un programme antivirus.
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Résolution des problémes généraux (suite)

Probléme

Cause

Solution

Vous observez de faibles
performances.
(suite)

Trop d'applications
en cours d’exécution.

1. Fermez les applications non
utilisées pour libérer de la
mémoire.

2. Ajoutez de la mémoire.

Cause inconnvue.

Redémarrez 'ordinateur.

L'ordinateur s’est éteint
automatiquement et le
voyant d’alimentation
rouge clignote deux
fois, & une seconde
d’intervalle, puiss'arréte
de clignoter pendant
deux secondes et
I'ordinateur émet

deux signaux sonores.

La protection thermique du
processeur est activée :

Il se peut qu’un ventilateur
soit bloqué ou ne tourne
pas.

ou

il se peut que le dissipateur
thermique ne soit pas
correctement fixé sur

le processeur.

1. Vérifiez que les aérations de
I'ordinateur ne sont pas obstruées
et que le ventilateur du processeur
fonctionne.

2. Ouvrez le capot, appuyez
sur le bouton d’alimentation
et vérifiez que le ventilateur
du processeur tourne. Si le
ventilateur du processeur ne
tourne pas, vérifiez que son
cdble est connecté & la carte
mére. Vérifiez que le ventilateur
est correctement mis en place.

3. Si le ventilateur est correctement
branché et mis en place, mais
ne tourne pas, remplacezle.

4. Remettez le dissipateur thermique
du processeur en place et vérifiez
que le ventilateur est
convenablement fixé.

5. Adressez-vous & un revendeur
ou un mainfeneur agréé.

Le systéme ne démarre
pas et les voyants

du panneau avant

de 'ordinateur ne
clignotent pas.

Impossible de mettre
le systéme sous tension.

Appuyez sur le bouton d’alimentation
et maintenezle enfoncé pendant moins
de 4 secondes. Si le voyant vert du
disque dur s’allume :

1. Vérifiez que le sélecteur de tension,
situé & 'arriére de I'alimentation
(sur certains modéles), est réglé
sur la tension appropriée. Le choix
de la tension dépend de la tension
secteur de votre pays.
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Résolution des problémes généraux (suite)

Probléeme Cause Solution

Le systéme ne démarre  Impossible de mettre 2. Retirez les cartes d’extension une
pas et les voyants le systéme sous tension. a une, jusqu’a ce que le voyant
du panneau avant (suite) de tension auxiliaire de 3 V

de I'ordinateur ne de la carte mére s'allume.
clignotent pas. 3. Remplacez la carte mére.

(suite) ou

Appuyez sur le bouton d’alimentation
et maintenez-le enfoncé pendant
moins de 4 secondes. Si le voyant
vert du disque dur ne s’allume pas :

1. Vérifiez que I'ordinateur est
branché sur une prise secteur
en parfait état de marche.

2. Ouvrez le capot et vérifiez que
le céble du bouton d’alimentation
est correctement connecté & la
carte meére.

3. Vérifiez que les deux cébles
d’alimentation sont correctement
connectés & la carte mére.

4. Vérifiez que le voyant de tension
auxiliaire de 3 V est allumé sur
la carte mére. Si le voyant est
allumé, remplacez le céble
du bouton d’alimentation.

5. Si le voyant de tension auxiliaire
de 3 V n’est pas allumé,
remplacez |'alimentation.

6. Remplacez la carte mére.
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Résolution des problemes d’alimentation

Le tableau suivant répertorie les causes les plus fréquentes
des problemes d’alimentation et vous propose des solutions.

Résolution des problémes d’alimentation

Probléme

Cause

Solution

L'alimentation se coupe
de facon intermittente.

Le sélecteur de tension
a l'arriére du chassis de
I'ordinateur (sur certains
modéles) n’est pas
réglé sur la tension

secteur appropriée
(115Vou230V,)

Réglez le sélecteur sur la tension
secteur appropriée.

L'alimentation ne se
met pas en marche
en raison d’une panne
d’alimentation interne.

Adressez-vous & un mainteneur
agréé pour obtenir le remplacement
de I'alimentation.

L'ordinateur s’est éteint
automatiquement et le
voyant d’alimentation
rouge clignote deux fois,
& une seconde d’infervalle,
puis s'arréte de clignoter
pendant deux secondes

et I'ordinateur émet deux
signaux sonores.

La protection thermique
du processeur
est activée :

Il se peut qu'un
ventilateur soit bloqué
ou ne tourne pas.

Oou

Il se peut que le
dissipateur thermique
ne soit pas correctement
fixé sur le processeur.

1. Vérifiez que les aérations
de I'ordinateur ne sont pas
obstruées et que le ventilateur
du processeur fonctionne.

2. Ouvrez le capot, appuyez
sur le bouton d’alimentation
et vérifiez que le ventilateur
du processeur tourne. Si le
ventilateur du processeur ne
tourne pas, vérifiez que son
cdble est connecté a la carte
mére. Vérifiez que le ventilateur
est correctement mis en place.

3. Si le ventilateur est correctement
branché et mis en place, mais
ne tourne pas, remplacezle.

4. Remettez le dissipateur thermique
du processeur en place et vérifiez
que le ventilateur est
convenablement fixé.

5. Adressez-vous & un revendeur
ou un mainteneur agréé.
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Résolution des problémes d’alimentation (suite)

Probléme Cause

Solution

Le voyant d’alimentation

Alimentation défaillante

rouge clignote quatre fois,  (en surcharge).

& une seconde d'infervalle,
puis s'arréte de clignoter
pendant deux secondes,
et I'ordinateur émet quatre
signaux sonores.

1. Vérifiez que le sélecteur

de tension, situé a 'arriére
de |'alimentation (sur certains
modéles), est réglé sur la
tension appropriée. Le choix
de la tension dépend de la
tension secteur de votre pays.

. Ouvrez le capot et vérifiez que

le cable d'alimentation & quatre
conducteurs est bien connecté
a la carte mére.

. Assurez-vous que le probléme

n'est pas causé par un
périphérique en retirant TOUS
les périphérique installés (disque
dur, unité de disquette, unité
optique et cartes d'extension).
Démarrez le systéme. Si le
systéme effectue |'autotest &

la mise sous tension (POST),
éteignez |'ordinateur et replacez
un & un les périphériques en
recommencant la procédure
jusqu’a ce que la défaillance

se produise. Remplacez le
périphérique qui provoque

la défaillance. Continuez

a remettre les périphériques

un & un pour vérifier qu'ils
fonctionnent tous correctement.

4. Adressez-vous d un

mainteneur agréé pour
obtenir le remplacement
de I'alimentation.

5. Remplacez la carte mére.
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Résolution des problemes de disquette

Le tableau suivant répertorie les causes les plus fréquentes des problémes
de disquette et vous propose des solutions.

% Lorsque vous ajoutez ou retirez du matériel, par exemple une unité
de disquette supplémentaire, vous pouvez étre amené a reconfigurer
I’ordinateur. Pour connaitre la marche a suivre, reportez-vous a la
section “Résolution des problémes d’installation de matériel”.

Résolution des problémes de disquette

Probléme

Cause

Solution

Le voyant de I'unité de
disquette reste allumé.

La disquette est abimée.

Sous Windows XP, cliquez avec

le bouton droit de la souris sur
Démarrer, cliquez sur Explorer,
et sélectionnez une unité. Sélectionnez
Fichier > Propriétés > Outils.
Sous Vérification des erreurs,
cliquez sur Vérifier maintenant.

La disquette n’est pas
insérée correctement.

Enlevez la disquette et réinsérez-la.

Le cable de |'unité
n'est pas raccordé
correctement.

Reconnectez le cable de |'unité
Vérifiez que les quatre broches
du cable d’alimentation sont
connectées & l'unité.

Lecteur introuvable.

Connecteur mal
enfoncé.

Reconnectez le cable de données
et le cable d’alimentation de |'unité
de disquette.

L'unité amovible n’est
pas correctement mise

en place.

Remettez |'unité en place.
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Résolution des problémes de disquette (suite)

Probléme

Cause

Solution

L'unité de disquette ne peut

écrire sur une disquette.

Disquette non formatée.

Formatez la disquette.

1. Dans Explorateur Windows,
sélectionnez |'unité (A).

2. Cliquez avec le bouton droit de
la souris sur la lettre de 'unité et
sélectionnez Formater.

3. Sélectionnez les options
de votre choix, puis cliquez
sur Démarrer pour lancer
le formatage.

La disquette est protégée
en écriture.

Utilisez une autre disquette ou
enlevez la protection en écriture.

Ecriture sur la mauvaise
unité.

Vérifiez la leftre d'unité indiquée
dans le chemin d’accés.

Il ne reste pas assez de
volume de mémoire sur
la disquette.

1. Utilisez une autre disquette.

2. Supprimer les fichiers inutiles
de la disquette.

L'écriture sur les
anciennes disquettes
a été désactivée dans
Computer Setup.

Lancez |'utilitaire Computer Setup et
activez |'option Legacy Diskette
Write dans le menu Storage >
Storage Options.

La disquette est abimée.

Remplacez la disquette
par une disquette neuve.

Impossible de formater
une disquette

Support incorrect
signalé.

Lorsque vous formatez une disquette
sous MS-DOS, vous pouvez éire
amené & indiquer la capacité de la
isquette. Par exemple, pour formater
une disquette de 1,44 Mo, tapez
la commande suivante a l'invite
MS-DOS :

FORMAT A: /F:1440
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Résolution des problémes de disquette (suite)

Probléme

Cause

Solution

Impossible de formater
une disquette.
(suite)

La disquette est
peut-étre protégée
en écriture.

Ouvrez la protection en écriture
de la disquette.

Le contréle d’écriture
de disquette est activé.

Lancez I'utilitaire Computer Setup et
activez |'option Legacy Diskette
Write dans le menu Storage >
Storage Options.

Probléme de transaction
de disquette.

La structure du répertoire
est mauvaise ou le fichier
a un probléme.

Sous Windows XP, cliquez avec

le bouton droit de la souris sur
Démarrer, cliquez sur Explorer,
et sélectionnez une unité.
Sélectionnez > Fichier >
Propriétés > Outils. Sous
Vérification des erreurs,
cliquez sur Vérifier maintenant.

L'unité de disquette ne peut
pas lire une disquette

Vous utilisez le mauvais
type de disquette pour
I'unité en question.

Vérifiez le type de 'unité et utilisez
un type de disquette adéquat.

Vous lisez la mauvaise
unité.

Vérifiez la lettre d'unité indiquée
dans le chemin d’accés.

La disquette est abimée.

Remplacez la disquette
par une disquette neuve.

Le message “Disque
non-systéme” est affiché.

Une disquette ne
contenant pas les
fichiers systéme
nécessaires au
démarrage de

votre ordinateur a été
introduite dans |'unité.

Lorsque le voyant d'activité s'éteint,
retirez la disquette et appuyez sur
la barre d’espace. L'ordinateur
devrait maintenant démarrer
normalement.

Une erreur de disquette
s'est produite.

Redémarrez I'ordinateur

en appuyant sur le bouton
Marche/Arrét.
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Résolution des problémes de disquette (suite)

Probléme

Cause

Solution

Impossible de démarrer
a partir de la disquette.

La disquette n’est pas
amorcable.

Insérez une disquette amorcable.

L'initialisation & partir
d’une disquette a été
désactivée dans
Computer Setup.

1. Lancez I'utilitaire Computer Setup
etactivez |'amorcage sur disquette
dans le menu Storage >
Boot Order.

2. Lancez I'utilitaire Computer Setup
et activez la disquette dans le
menu Storage > Storage
Options > Removable
Media Boot.

@y, Les deux opérations doivent
étre faites, étant donné que
la fonction d’amorgage a
partir d’'un support amovible
(Removable Media Boot)
de Computer Setup a la
priorité sur la commande
d’ordre d'amorgage

(Boot Order).

Le mode serveur de
réseau est activé dans
Computer Setup.

Exécutez Computer Setup et
désactivez Network Server
Mode dans Security >
Password Options.

Le démarrage & partir
d’un support amovible
a été désactivé

dans |'utilitaire
Computer Setup.

Lancez |'utilitaire Computer Setup
et activez |'option Removable
Media Boot dans le menu
Storage > Storage Options >
Removable Media Boot.
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Résolution des probléemes de disque dur

Résolution des problémes de disque dur

Probléeme Cause Solution
Une erreur s'est produite Le disque dur présente 1. Sous Windows XP, cliquez
sur le disque dur. des secteurs défaillants avec le bouton droit de la

ou est en panne. souris sur Démarrer, cliquez

sur Explorer, et sélectionnez
une unité. Sélectionnez Fichier >
Propriétés > Outils. Sous
Vérification des erreurs,
cliquez sur Vérifier
maintenant.

2. Utilisez un utilitaire pour repérer
et bloquer |'utilisation des secteurs
défectueux. Si nécessaire,
reformatez le disque dur.

Probléme de transaction La structure du répertoire  Sous Windows XP, cliquez avec
sur le disque. est mauvaise ou un le bouton droit de la souris sur
fichier est incorrect. Démarrer, cliquez sur Explorer,

et sélectionnez une unité. Sélectionnez
Fichier > Propriétés > Outils.
Sous Vérification des erreurs,
cliquez sur Vérifier maintenant.

Unité introuvable Connecteur peut-étre Vérifiez la connexion des cables.
(non identifige). mal enfoncé.
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Résolution des problémes de disque dur (suite)

Probléme

Cause

Solution

Unité introuvable
(non identifige).
(suite)

Le systéme n'a
probablement

pas reconnu
automatiquement
un périphérique
récemment installé.

Reportez-vous aux consignes

de reconfiguration & la section
“Résolution des problémes
d'installation de matériel”. Si le
systéme ne détecte toujours pas

le nouveau périphérique, vérifiez
qu'il figure bien dans la liste de
Computer Setup. S'il est repris dans
la liste, alors il s’agit probablement
d'un probléme de driver. S'il ne
figure pas dans la liste, il s’agit
d'un probléme matériel.

Dans le cas d'un lecteur récemment
installé, exécutez I'utilitaire
Computer Setup et essayez
d’ajouter un délai de test POST
dans le menu Advanced >
Power-On.

Le réglage des
cavaliers de I'unité est
peut-étre incorrect.

S'il s’agit du disque principal,
placez le cavalier sur la position
“Master” ou “Cable Select”. S'il
‘agit d'un di d dai
s'agit d'un disque dur secondaire,
placez le cavalier sur “Slave” ou
“Cable Select”.

Le controleur de
I'unité est désactivé
dans I'utilitaire
Computer Setup.

Lancez |'utilitaire Computer Setup
et activez tous les contréleurs IDE

et SATA dans le menu Storage >
Storage Options.

L'unité fonctionne au
ralenti immédiatement
aprés le démarrage.

Lancez |'utilitaire Computer Setup et
augmentez la valeur de délai

POST dans le menu Advanced >
Power-On Options.
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Résolution des problémes de disque dur (suite)

Probléme

Cause

Solution

Message Disque
non-systéme/NTLDR

manquant.

Le systéme essaie de

démarrer & partir d’'une

disquette qui n’est pas
amorcable.

Retirez la disquette de son unité.

Le systéme essaie

de démarrer & partir
du disque dur mais

ce dernier est peut-étre
endommagé.

1. Insérez une disquette amorcable

dans 'unité de disquette

et redémarrez |'ordinateur.

. Vérifiez le format du disque dur

& I'aide de la commande fdisk :
Dans le cas du formatage
NFTFS, utilisez un programme
de lecture tiers pour évaluer

le disque dur.

Dans le cas du formatage
FAT32, il nest pas possible
d’accéder au disque dur.
Remplacez I'image MBR.

. Si le disque dur est
toujours inaccessible aprés

la réinitialisation et que la
sécurité MBR est active, essayez
de restaurer I'image MBR
précédemment enregistrée.
Pour cefaire, exécutez ' utilitaire

Computer Setup et sélectionnez

Security > Restore Master
Boot Record.

www.hp.com
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Résolution des problemes sans diagnostic

Résolution des problémes de disque dur (suite)

Probléme

Cause

Solution

Message Disque
non-systéme/NTLDR
manquant.

(suite)

Fichiers systéme
manquants ou
mal installés.

1. Insérez une disquette
amorgable dans |'unité
de disquette et redémarrez
I'ordinateur.

2. Vérifiez le format du disque dur
& I'aide de la commande fdisk :
Dans le cas d'un formatage
NFTFS, utilisez un programme
de lecture tiers pour évaluer
le disque.

Dans le cas du formatage
FAT32, il nest pas possible
d’accéder au disque dur.
Remplacez I'image MBR.

Si le disque dur est toujours
inaccessible apreés la réinitialisation
et que la sécurité MBR est active,
essayez de restaurer I'image

MBR précédemment enregistrée.
Pour ce faire, exécutez |'utilitaire
Computer Setup et sélectionnez
Security > Restore Master
Boot Record.

L'initialisation & partir
d’un disque dur a été
désactivée dans
Computer Setup.

Exécutez |'utilitaire Computer Setup
et activez |'entrée disque dur dans
le menu Storage > Boot Order
(ordre d’amorcage des
périphériques de stockage).

Le disque dur
d’amorcage n’est
pas connecté comme
premier disque dans
une configuration

a plusieurs disques.

Si vous tentez d'amorcer & partir
d'un disque dur IDE, vérifiez qu'il
est connecté comme périphérique
primaire O. Si vous tentez |'amorcage

& partir d’un disque dur SATA,

vérifiez qu'il est connecté & SATA O.
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Résolution des problémes de disque dur (suite)

Probléeme Cause Solution

Message Disque Le contréleur du disque  Lancez Computer Setup et

non-systéme/NTLDR dur amorgable ne figure  sélectionnez Storage > Boot

mangquant. pas comme premier Order pour vérifier que le

(suite) périphérique dans contréleur de disque dur amorcable
I'ordre d’amorgage. figure immédiatement aprés |'entrée

Hard Drive.

Le disque dur PATA Vous n'utilisez pas le Réinstallez le disque dur Ultra ATA

(Parallel ATA) ne fonctionne  céble correspondant en utilisant un céble & 80 conducteurs.

pas de facon optimale. au type de disque dur.

L'ordinateur refuse Le disque dur Vérifiez si le voyant d’alimentation

de démarrer. est endommagé. rouge clignote & |'avant de

I'ordinateur et si des signaux
sonores sont émis. Pour déterminer
les causes possibles de clignotement
rouge et les codes des signaux
sonores, reporfez-vous &

I’Annexe A, “Messages d’erreur du
test POST”.

Pour plus d'informations,
reportez-vous & la Déclaration
de garantie limitée.

L'ordinateur semble Le programme utilisé a  Essayez de lancer la procédure
bloqué. cessé de répondre aux  d’arrét standard de Windows.
commandes. Si vous ny arrivez pas, éteignez

I'ordinateur en appuyant sur le
bouton d’alimentation pendant
au moins quatre secondes. Pour
redémarrer |'ordinateur, appuyez
de nouveau sur le bouton
d’alimentation.
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Résolution des problemes MultiBay

Résolution des problémes MultiBay

Probléme

Cause

Solution

Lecteur introuvable.

Vous avez tenté de
connecter & chaud

un disque dur amovible
sur lequel la fonction de
sécurité Drivelock est
activée (fonction prise
en charge sur certains
modéles uniquement).

Quittez Windows et éteignez
I'ordinateur. Insérez |'unité dans
le compartiment MultiBay, si ce
n'est pas déja fait. Allumez votre
ordinateur.

La fonction MultiBay
est masquée dans
Computer Setup.

Lancez Computer Setup et
sélectionnez Device Available
pour MultiBay dans le menu
Security > Device Security.

Résolution des problemes d’affichage

Si vous rencontrez des problemes d’affichage, reportez-vous a la
documentation livrée avec le moniteur et au tableau ci-dessous pour
connaitre leurs causes les plus fréquentes et leurs solutions.

Résolution des problemes d’affichage

Probléeme

Cause

Solution

Ecran noir
(pas de signal vidéo).

Le moniteur n’est

pas sous tension et

le voyant du moniteur
n'est pas allumé.

Mettez le moniteur sous tension et
vérifiez que le voyant du moniteur
est allumé.

Moniteur défectueux.

Essayez un autre moniteur.

Les connexions de
cdables sont incorrectes.

Vérifiez les connexions de cables
du moniteur vers 'ordinateur et
vers la prise secteur.
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Résolution des problémes d’affichage (suite)

Probléme

Cause

Solution

Ecran noir (pas
de signal vidéo).
(suite)

Présence d’un

économiseur d’écran ou
activation des fonctions
d’économie d'énergie.

Appuyez sur une touche ou cliquez
sur le bouton de la souris, puis tapez
le mot de passe s'il a été défini.

La ROM systeme est
défectueuse ; le systéme
fonctionne en mode
Failsafe Boot Block
(indiqué par huit

signaux sonores).

Réécrivez la ROM & |'aide de

la disquette ROMPagq. Pour plus
d'informations, reportez-vous &

la section “Bloc d’amorcage ROM
FailSafe” du Manuel de supervision
des ordinateurs de bureausur le
CD Documentation.

Vous utilisez un moniteur
& synchronisation fixe
etil n’est pas synchrone
d la résolution choisie.

Assurez-vous que |'écran peut
accepter la méme fréquence de
balayage que la résolution choisie.

U'ordinateur est
en mode veille.

Appuyez sur le bouton d'alimentation
pour sortir du mode veille.

A ATTENTION : si vous tentez de sortir du mode veille, maintenez enfoncé le bouton
d’alimentation pendant moins de quatre secondes. Sinon, 'ordinateur s’arrétera
et vous perdrez vos données.

Ecran noir (pas
de signal vidéo).

Le cable du moniteur
est branché dans le
mauvais connecteur.

Si I'ordinateur est équipé d'un
connecteur de carte graphique
intégrée et d'un connecteur de
carte graphique supplémentaire,
branchez le cable de I'écran sur
le connecteur de carte graphique
a l'arriére de |'ordinateur.

Si la carte graphique est une carte
d’extension PCl standard, vous
pouvez activer la carte graphique
intégrée dans Computer Setup. Si
une carte graphique PCl-Express
est installée, vous ne pouvez pas
activé la carte graphique intégrée.
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Résolution des problémes d’affichage (suite)

Probléme

Cause

Solution

Ecran noir (pas
de signal vidéo).
(suite)

Les paramétres
d’affichage de
I'ordinateur ne

sont pas compatibles
avec |'écran.

1.

Redémarrez |'ordinateur et
appuyez sur F8 lorsque vous
voyez apparaitre le message
“Press F8” (Appuyez sur F8)
dans I'angle inférieur droit
de I'écran.

. En vous servant des touches

de direction du clavier,
sélectionnez Enable VGA
Mode (Activer le mode
VGA), puis appuyez sur
Entrée.

. Dans le Panneau de

configuration, double<liquez
sur I'icone Affichage

et sélectionnez |'onglet
Parametres.

. Rétablissez la résolution d’écran

& I'aide de la glissiére.

Ecran noir et voyant
d’alimentation rouge
clignotant cinq fois, & une
seconde d'intervalle, puis
s'arrétant de clignoter
pendant deux secondes,
et cing signaux sonores
émis par |'ordinateur.

Erreur de mémoire
prévidéo.

. Retirez et remettez en place

les modules DIMM. Démarrez
le systéme.

. Retirez et replacez un & un

les modules mémoire pour
isoler le module défaillant.

. Remplacez les modules

mémoire de fabricants
tiers par des modules HP.

. Remplacez la carte mére.
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Résolution des problémes d’affichage (suite)

Probléme

Cause

Solution

Ecran noir et voyant
d’alimentation rouge
clignotant six fois, &
une seconde d’intervalle,

puis s'arrétant de clignoter

pendant deux secondes,
et six signaux sonores
émis par |'ordinateur.

Erreur graphique
prévidéo.

Systémes avec carte graphique :

1. Retirez et remettez la carte
graphique en place. Démarrez
le systéme.

2. Remplacez la carte graphique.
3. Remplacez la carte mére.

Dans le cas de systémes avec
carte graphique intégrée,
remplacez la carte mére.

Ecran noir et voyant
d’alimentation rouge
clignotant sept fois, & une
seconde d'intervalle, puis
s'arrétant de clignoter
pendant deux secondes,
et sept signaux sonores
émis par |'ordinateur.

Carte mére défectueuse
(détection d’une
défaillance ROM
avant vidéo).

Remplacez la carte mére.

Le moniteur ne fonctionne
pas correctement avec
les fonctions d’économie
d’énergie.

Utilisation d’un moniteur
ne possédant pas de
fonctions d’économie
d’énergie alors que ces
fonctions sont actives.

Désactivez la fonction d’économie
d’énergie du moniteur.

Les caractéres
affichés sont péles.

Mauvais réglage
de la luminosité
et du contraste.

Réglez la luminosité et
le contraste du moniteur.

Les cébles ne sont pas
branchés correctement.

Vérifiez que le cable de carte
graphique est correctement
connecté & la carte vidéo

et au moniteur.
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Résolution des problémes d’affichage (suite)

Probléeme Cause Solution

L'image est floue ou vous Si vous avez Installez les drivers vidéo que vous
ne parvenez pas & définir  mis & niveau votre trouverez sur la disquette livrée avec
la résolution voulue. contréleur graphique, le kit de mise a niveau.

les gestionnaires
graphiques adéquats
ne sont peut-étre

pas chargés.

L'écran ne parvient pas  Spécifiez une autre résolution.
a afficher la résolution

demandée.
Mauvaise carte Remplacez la carte graphique.
graphique.
L'image est morcelée, Les connexions 1. Vérifiez que le céble du
ondule, saute ou clignote.  du moniteur moniteur est correctement
sont incomplétes relié a l'ordinateur.
ou le moniteur 2. Dans le cas d'un systéme &

est mal réglé. deux écrans, ou si un autre

écran se trouve a proximité,
assurez-vous que leurs champs
magnétiques n'interférent pas
en les éloignant I'un de I'autre.

3. Des lumiéres fluorescentes ou
des ventilateurs sont peut-étre
trop proches du moniteur.

L'écran doit étre Démagnétisez |'écran. Reportez-vous
démagnétisé. & la documentation livrée avec
Iécran.
Vibration ou claquement La bobine de Aucune. L'activation de la bobine
produit & la mise sous démagnétisation de de démagnétisation & la mise sous
tension d'un écran I'écran a été activée. tension est normale.

cathodique.
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Résolution des problémes d’affichage (suite)

Probléme

Cause

Solution

Cliquetis produits & la mise

sous tension d'un écran
cathodique.

Des relais électroniques
ont été activés a
I'intérieur de I'écran.

Aucune. Certains écrans produisent
ce bruit d’enclenchement & la mise
sous tension ou hors tension,

au changement de résolution,

ou encore lorsque le mode

veille est activé.

Bruit aigu provenant de

I"intérieur d'un écran plat.

La luminosité et/ou le

contraste sont trop élevés.

Réduisez la luminosité
ou le contraste.

Image flove, zébrée,
avec effets d’'ombre

ou d’image secondaire ;
lignes horizontales
défilantes ; traces

de bandes verticales ;
impossible de centrer
I'image.

(écrans plats ne
comportant qu’une
entrée VGA analogique)

Les circuits internes

des écrans plats pour
la conversion numérique
des signaux analogiques
peuvent étre incapables
d’interpréter
correctement le signal
de synchronisation de

la carte graphique.

1. Sélectionnez |'option
de réglage automatique

dans le menu OSD.

2. Synchronisez manuellement
les fonctions Horloge et Phase
d’horloge dans le menu OSD.
Pour faciliter cette synchronisation,
un SoftPaq est disponible sur
le site Web ci-dessous.
Sélectionnez-y|'écran approprié
et téléchargez le SP20930
ou le SP22333 :
www.hp.fr/support

Carte graphique mal
insérée ou défectueuse.

1. Réinsérez la carte graphique.
2. Remplacez la carte graphique.

Certains symboles
ne s'affichent pas
correctement.

Ces symboles ne sont
pas pris en charge par
la police de caractéres
utilisée.

Recherchez et sélectionnez

le symbole en question dans la
Table de caractéres. Cliquez sur
Démarrer > Programmes >
Accessoires > Outils systéme >
Table de caractéres. Vous pouvez
copier le symbole de votre choix dans
un document.
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Résolution des problemes sans diagnostic

Résolution des problemes audio

Si I’ordinateur est équipé de fonctions audio et que vous rencontrez
des problemes de son, reportez-vous au tableau ci-dessous pour
connaitre leurs causes les plus fréquentes ainsi que leurs solutions.

Résolution des problémes audio

Probléme Cause Solution
Le son est coupé Les ressources du Fermez toutes les applications
par intermittence. processeur sont demandant beaucoup de ressources.

utilisées par d’autres
applications.

Retard de Direct Sound,
fréquent pour de
nombreux lecteurs
audio.

Dans Windows XP :

1. Dans le Panneau de
configuration, sélectionnez
Sons, voix et périphériques
audio.

2. A l'onglet Audio, sélectionnez
un périphérique dans la liste
Lecture audio.

3. Dans la boite de dialogue
Propriétés audio
avancées, cliquez sur
le bouton Parameétres
avancés et sélectionnez
I'onglet Performances.

4. Placez la glissiére Accélération
matérielle sur Aucune
et la glissiére Qualité de
conversion du taux
d’échantillonnage sur
Bonne, puis retester |'audio.

Placez la glissiére Accélération
matérielle sur Compléte et la
glissiére Qualité de conversion
du taux d’échantillonnage sur
Optimale, puis retester |'audio.
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Résolution des problémes audio (suite)

Probléme

Cause

Solution

Les haut-parleurs ou le
casque ne produisent
aucun son.

Le volume du logiciel
est frop baissé.

Double-cliquez sur I'icéne
Haut-parleur de la barre des
taches, puis vérifiez que la case
& cocher Muet n’est pas cochée
et déplacez la glissiére pour
régler le volume.

Les fonctions audio
sont masquées dans
Computer Setup.

Activer les fonctions audio dans
Computer Setup : Security >
Device Security > Audio.

Les haut-parleurs
externes ne sont
pas sous tension.

Mettez sous tension les
haut-parleurs externes.

Haut-parleurs

externes branchés sur
la mauvaise prise jack
audio.

Consultez la documentation
de la carte son pour brancher
correctement les haut-parleurs.

La lecture numérique
pour CD audio n’est
pas activée.

Activez la lecture numérique pour
CD audio :

1. Dans le Panneau de
configuration, sélectionnez
Systeme.

2. Al'onglet Matériel, cliquez
sur le bouton Gestionnaire
de périphériques.

3. Cliquez avec le bouton droit
de la souris sur le périphérique
CD/DVD et sélectionnez
Propriétés.

4. A l'onglet Propriétés, vérifiez
que la case “Activer la
lecture numérique de

CD audio sur ce lecteur
de CD-ROM’ est cochée.
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Résolution des problémes audio (suite)

Probléeme Cause Solution

Les haut-parleurs ou le Le casque ou les Allumez les haut-parleurs externes
casque ne produisent appareils raccordés ou utilisez le casque, s'ils sont
aucun son. a la sortie audio connectés, ou déconnectez-les.
(suite) désactivent le

haut-parleur interne.

Le volume a été
désactivé.

1. Dans le Panneau de
configuration, cliquez sur
Son, voix et périphériques
audio, puis cliquez sur Sons
et périphériques audio.

2. Supprimez la coche
de la case Muet.

U'ordinateur est
en mode veille.

Appuyez sur le bouton d'alimentation
pour sortir du mode veille.

A ATTENTION : si vous tentez de sortir du mode veille, maintenez enfoncé le bouton
d’alimentation pendant moins de quatre secondes. Sinon, |'ordinateur s’arrétera

et vous perdrez vos données.

Les haut-parleurs ou le L'ordinateur ne détecte
casque produisent du pas correctement le
bruit ou aucun son. type ou la sortie

des haut-parleurs ou
du casque, ou bien la
détection automatique
analogique-vers-
numérique n’est

pas activée.

1. Si vous utilisez des haut-parleurs
numériques dotés d’une prise
jack stéréo et si vous souhaitez
que le systéme passe
automatiquement en mode
numérique, servez-vous d'un
adaptateur stéréo-vers-mono
de facon & activer la fonction
de détection automatique.

2. Si vous ne disposez pas d'un
adaptateur stéréo-vers-mono,
passez par les propriétés du
périphérique multimédia pour
commuter manuellement le
signal audio d’analogique
en numérique.
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Résolution des problémes audio (suite)

Probléeme Cause Solution

Les haut-parleurs ou le L'ordinateur ne détecte 3. Sile casque comporte une prise
casque produisent du pas correctement le jack mono, utilisez les propriétés
bruit ou aucun son. type ou la sortie des du périphérique multimédia
(suite) haut-parleurs ou du pour faire passer le systéme

casque, ou bien la
détection automatique
analogique-vers-
numérique n’est

pas activée.

en mode sortie analogique.

Pour plus d'informations sur le
changement de mode de sortie
audio, reportez-vous & I’Annexe D,
“Configuration de la sortie audio
analogique/numérique.”

If you set digital as the Si vous sélectionnez le mode de sortie numérique, le
hautparleur interne et les haut-parleurs externes analogiques ne fonctionneront
pas tant que vous ne réglerez pas de nouveau le mode de sortie sur analogique

ou sur détection automatique.

Si vous sélectionnez le mode analogique, les haut-parleurs numériques externes ne
fonctionneront pas tant que vous ne réglerez pas de nouveau le mode de sortie

sur numérique ou sur détection automatique.

Pour de plus amples informations, reportez-vous & I'’Annexe D, “Configuration de la

sortie audio analogique/numérique”.

L'ordinateur semble bloqué  Le disque dur est
pendant |'enregistrement peut-étre plein.
audio.

Avant tout enregistrement audio,
vérifiez qu'il reste suffisamment
d’espace libre sur votre disque dur.
Vous pouvez également essayer
d’enregistrer le fichier audio dans
un format compressé.
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Résolution des problemes d’imprimante

Si vous rencontrez des problémes d’imprimante, reportez-vous a la
documentation fournie avec le périphérique et au tableau ci-dessous.

Résolution des probléemes d’imprimante

Probléme

Cause

Solution

L'imprimante
n‘imprime pas.

L'imprimante n’est pas
allumée et n’est pas en
ligne.

Mettez |'imprimante sous tension
et assurez-vous qu’elle est en ligne.

Vous n’avez pas installé
les drivers d'imprimante
correspondant & votre
application.

1. Installez le driver d’'imprimante
requis pour votre application.

2. Essayez d'imprimer via

la commande MS-DOS :
DIR C:\ > [port imprimante]

ou [port imprimante]
correspond a I'adresse

de I'imprimante utilisée.

Si I'imprimante fonctionne,
rechargez le driver
d'imprimante.

Si vous étes en
réseau, la connexion
a l'imprimante n'a
peut-étre pas été
établie.

Effectuez les connexions réseau
nécessaires vers |'imprimante.

Panne possible
de I'imprimante.

Lancez I'autotest de I'imprimante.
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Résolution des problémes d’imprimante (suite)

Probléeme Cause Solution
L'imprimante Les cébles ne sont pas  Rebranchez tous les cables,
ne s'allume pas. branchés correctement.  vérifiez le cordon d’alimentation

et la prise secteur.

L'imprimante imprime des ~ Vous n’avez pas installé  Installez le driver d'imprimante
informations tronquées. le driver d'imprimante  requis pour votre application.
correspondant & votre
application.

Les cables ne sont pas  Rebranchez tous les cébles.
branchés correctement.

La mémoire Réinitialisez I'imprimante :

de I'imprimante éteignez-la et attendez environ

est saturée. une minute, puis rallumez-la.
L'imprimante est hors ligne. 1l n'y a plus de papier.  Vérifiez qu'il reste du papier dans le

bac d'alimentation et remplissez-le
s'il est vide. Mettez |'imprimante
en ligne.
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Résolution des problemes de clavier et de souris

Si vous rencontrez des problemes de clavier ou de souris, reportez-vous
a la documentation fournie par le fabricant et au tableau ci-dessous.

Résolution des problémes de clavier

Probléeme Cause Solution
Votre ordinateur Le connecteur du clavier 1. A partir du Bureau
ne reconnait pas est mal raccordé. de Windows, cliquez

les commandes ou
les combinaisons de
touches du clavier.

sur Démarrer.

2. Cliquez sur Arréter. La
boite de dialogue Arrét
de Windows apparait.

3. Cliquez sur Arréter.

4. Une fois la procédure d'arrét
terminée, reconnectez le clavier
a I'arriére de I'ordinateur
et redémarrez 'ordinateur.

Le programme utilisé
a cessé de répondre
aux commandes.

Arrétez |'ordinateur & |'aide de la
souris, et redémarrez |'ordinateur.

Le clavier doit
étre réparé.

Pour plus d'informations,
reportez-vous & la Déclaration
de garantie limitée.

l'ordinateur est
en mode veille.

Appuyez sur le bouton d'alimentation
pour sortir du mode veille.

A ATTENTION : si vous tentez de sortir du mode veille, maintenez enfoncé le bouton
d’alimentation pendant moins de quatre secondes. Sinon, |'ordinateur s’arrétera et

vous perdrez vos données.

Le curseur ne se déplace La touche Verr num
pas lorsque les touches est enclenchée.

de direction du pavé

numérique sont utilisées.

Appuyez sur la touche Verr num.
Si vous voulez utiliser les touches
de direction, le voyant Verr num doit
étre éteint. La touche Verr num
peut étre désactivée (ou activée)
dans Computer Setup.

Manvuel de résolution des probléemes www.hp.com

2-33



Résolution des problémes sans diagnostic

Résolution des problémes de souris

Probléme

Cause

Solution

Le curseur est trop lent ou
ne suit pas les mouvements
de la souris.

Le connecteur de
la souris n’est pas
convenablement
branché a l'arriére
de l'ordinateur.

Eteignez |'ordinateur & I'aide
du clavier.

1. Appuyez simultanément sur

les touches Ctrl et Echap

(ou appuyez sur la touche du
logo Windows) pour afficher
le menu Démarrer.

. En vous servant des touches

de direction, amenez la barre
de sélection sur Arréter, puis
appuyez sur la touche Entrée.

. En vous servant des touches

de direction, amenez la barre
de sélection sur Arréter, puis
appuyez sur la touche Entrée.

. Une fois la procédure

d’arrét terminée, branchez
le connecteur de la souris

a l'arriére de I'ordinateur
(ou le clavier) et redémarrez
I'ordinateur.

Le programme utilisé
a cessé de répondre
aux commandes.

Arrétez |'ordinateur & |'aide du
clavier, et redémarrez I'ordinateur.
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Résolution des problémes de souris (suite)

Probléeme Cause Solution

Le curseur est frop lentou  Le nettoyage de la Otfez le couvercle de la bille et
ne suit pas les mouvements  souris est peut-étre nettoyez |'intérieur de la souris.
de la souris. nécessaire.

(suite)

La souris nécessite
peut-étre une
réparation.

Pour plus d'informations,
reportez-vous & la Déclaration
de garantie limitée.

U'ordinateur est
en mode veille.

Appuyez sur le bouton
d’alimentation pour sortir
du mode veille.

A ATTENTION : si vous tentez de sortir du mode veille, maintenez enfoncé le bouton
d’alimentation pendant moins de quatre secondes. Sinon, |'ordinateur s’arrétera et

vous perdrez vos données.

Le curseur de la La bille de la souris
souris ne se déplace est encrassée.
qu’horizontalement

ou verticalement ou son

mouvement est anormal.

Retirez la bille de la souris
et nettoyez-la avec un kit de
nettoyage disponible dans
la plupart des boutiques
d'informatique.
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Résolution des probléemes d’installation

de matériel

Lorsque vous ajoutez ou retirez du matériel, par exemple une unité
de disquette supplémentaire, vous pouvez €tre amené a reconfigurer
I’ ordinateur. Lorsque vous installez un périphérique Plug-and-Play,
Windows XP le détecte et configure I’ordinateur automatiquement.
Si le périphérique n’est pas Plug and Play, vous devez reconfigurer
votre ordinateur apres I'installation du nouveau périphérique. Dans
Windows XP, utilisez I’ Assistant d’ajout de matériel et suivez les
instructions qui apparaissent a I’écran.

Résolution des problémes d’installation de matériel

Probléme

Cause

Solution

Un nouveau périphérique

n'est pas détecté par
le systéme.

Le périphérique
est mal connecté.

Vérifiez que le périphérique est
correctement enfiché et que les
broches du connecteur ne sont
pas endommagées.

Le ou les cables du
nouveau périphérique
externe sont laches
ou les cordons
d’alimentation

sont débranchés.

Assurez-vous que tous les cables
sont correctement branchés et
que les broches du céble ou

du connecteur ne sont pas
endommagées.

Le nouveau
périphérique externe
n’est pas allumé.

Eteignez I'ordinateur, mettez le
périphérique externe sous tension,
puis rallumez |'ordinateur afin
d'intégrer le périphérique dans

le systéme.

Quand le systéme
vous a indiqué

des changements de
configuration, vous ne

les avez pas acceptés.

Redémarrez |'ordinateur et suivez
les instructions pour accepter les
changements.
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Résolution des problémes d’installation de matériel (suite)

Probléme

Cause

Solution

Un nouveau périphérique
n'est pas détecté par

le systéme.

(suite)

Si la configuration

par défaut d’une carte
Plug-and-Play entre en
conflit avec d’autres
périphériques, il se peut
qu’elle ne se configure
pas automatiquement.

Utilisez le Gestionnaire de
périphériques de Windows XP

afin de désélectionner les réglages
automatiques de la carte et de choisir
une configuration de base qui
n’entraine pas de conflit de
ressources. Vous pouvez également
utiliser Computer Setup pour
reconfigurer ou désactiver les
périphériques afin de résoudre

le conflit de ressources.

'ordinateur refuse
de démarrer.

Une augmentation de la
mémoire a été réalisée
avec des modules
mémoire non appropriés,
ou ceux-<i n‘ont pas été
installés & I'emplacement
requis.

1. Pour déterminer si vous utilisez
les bons modules de mémoire et
vérifier si |'installation est correcte,
consultez la documentation.

2. Surveillez les signaux sonores
et les voyants & I'avant de
I'ordinateur. Reportez-vous &
I’Annexe A, “Messages d'erreur
du test POST” pour connaitre
les causes possibles.

3. Sile probléme persiste, contactez
I"assistance technique.

Le voyant d’alimentation
rouge clignote cinq fois,

d une seconde d’intervalle,
puis s'arréte de clignoter
pendant deux secondes,
et I'ordinateur émet

cing signaux sonores.

La mémoire est
défectueuse ou
mal installée.

1. Retirez et remettez en place
les modules DIMM. Démarrez
le systéme.

2. Retirez et replacez un & un les
modules mémoire pour isoler
le module défaillant.

3. Remplacez les modules
mémoire de fabricants tiers
par des modules HP.

4. Remplacez la carte mére.
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Résolution des problémes d’installation de matériel (suite)

Probléme

Cause

Solution

Le voyant d’alimentation
rouge clignote six fois, &
une seconde d’intervalle,
puis s'arréte de clignoter
pendant deux secondes,
et I'ordinateur émet

six signaux sonores.

La carte vidéo est
défectueuse ou mal
installée dans son
connecteur, ou la carte
mere est défaillante.

Systémes avec carte graphique :

1. Retirez et remettez la carte
graphique en place. Démarrez
le systéme.

2. Remplacez la carte graphique.
3. Remplacez la carte mére.

Dans le cas de systémes avec carte
graphique intégrée, remplacez la
carte mére.

Le voyant d’alimentation
rouge clignote dix fois, &
une seconde d’intervalle,
puis s'arréte de clignoter
pendant deux secondes,
et l'ordinateur émet

dix signaux sonores.

Carte d’option
défectueuse.

1. Vérifiez toutes les cartes
d’option en les retfirant une &
une (dans le cas de plusieurs
cartes) et en redémarrant
le systéme pour vérifier si
le probléme est résolu.

2. Si vous identifiez une carte
défectueuse, retirez-la et
remplacez-la par une nouvelle.

3. Remplacez la carte mére.
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Résolution des probléemes de réseau

Le tableau suivant indique les causes fréquentes de problemes réseau,
ainsi que leurs solutions. Les opérations de débogage du cablage

réseau ne sont pas abordées.

Résolution des problémes de réseau

Probléme Cause Solution
Le réveil & distance La fonction de réveil Activez la fonction de réveil
ne fonctionne pas. a distance (WOL) a distance.
, A
n'est pas activee. 1. Sélectionnez Démarrer >

(6]

Panneau de configuration.

. Double-cliquez sur

Connexions réseau.

. Double<liquez sur

Connexion réseau local.

. Cliquez sur Propriétés.
. Cliquez sur Configurer.
. Cliquez sur I'onglet Gestion

de I"alimentation, puis
cochez la case & cocher
Autoriser ce périphérique
a sortir cet ordinateur

de la mise en veille.

Le driver de réseau ne Le contréleur de 1.

détecte pas le contréleur  réseau est désactivé.
réseau. 2

Exécutez Computer Setup et
activez le controleur réseau.

. Activez le controleur de

réseau dans le Gestionnaire
de périphériques du systéme
d’exploitation.

Driver de réseau incorrect.  Consultez la documentation du
contréleur réseau pour trouver le
gestionnaire correct ou télécharger
les derniers pilotes sur le site Web
du fabricant.
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Résolution des problémes de réseau (suite)

Probléme

Cause

Solution

Le voyant d’état de
la liaison réseau ne
clignote jamais.

@y, le voyant du

réseau doit
clignoter en cas
d’activité sur le
réseau.

Aucun réseau actif
! 7 ’
n'est détecté.

Vérifiez que les cébles et
le matériel réseau sont bien
connectés.

Le contréleur réseau
n'est pas configuré
correctement.

Vérifiez |"état du périphérique dans
Windows & |'aide du Gestionnaire
de périphériques pour le chargement
du driver et & I'aide de la fenétre
des connexions réseau pour |'état
de la liaison.

Le contréleur de réseau
est désactivé.

1. Exécutez Computer Setup et
activez le contrdleur réseau.

2. Activez le contréleur de réseau
dans le Gestionnaire de
périphériques du systéme
d’exploitation.

Le driver réseau n’est pas
bien installé.

Installez & nouveau les drivers
réseau. Voir le Manuel des
communications réseau et
Internet sur le CD Documentation.

Le systéme ne peut pas
détecter automatiquement
le réseau.

Désactivez les fonctions de
détection automatique et forcez

le systtme & accepter le mode

de fonctionnement correct. Voir le
Manuel des communications réseau
et Internet sur le CD Documentation.

Le programme de
diagnostics signale

Le céble n’est pas
fixé correctement.

Assurez-vous que le cdble est bien
fixé sur le connecteur du réseau et

une panne. que son autre extrémité est reliée
au bon périphérique.
Le cable est relié au Assurez-vous que le cable est
mauvais connecteur. branché au bon connecteur.
Probléme au niveau du Assurez-vous que le céble et que
cdble ou du périphérique  le périphérique & I'autre extrémité
a I'autre extrémité du fonctionnent correctement.
céble.
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Résolution des problémes de réseau (suite)

Probléme

Cause

Solution

Le programme de
diagnostics signale
une panne.

(suite)

L'IRQ de la carte réseau
est partfagée avec une
carte d’extension.

Dans le menu Advanced

de I'utilitaire Computer Setup,
modifiez les paramétres

de ressources de la carte.

Le contréleur réseau est
défectueux.

Adressez-vous & un revendeur
ou un mainfeneur agréé.

Le programme de
diagnostic ne signale
pas d’erreur, mais
I'ordinateur ne
communique pas
avec le réseau.

Les drivers du réseau ne
sont pas chargés ou les
paramétres du driver ne
correspondent pas & la

configuration actuelle.

Vérifiez que les drivers réseau
sont chargés et que les paramétres
du driver correspondent & la
configuration du contréleur réseau.

Vérifiez que le client et le protocole
réseau sont bien installés.

Le contréleur réseau
n’est pas configuré
pour cet ordinateur.

Cliquez sur I'icéne Réseau dans
le Panneau de configuration
et configurez le contréleur de réseau.

Le contrdleur réseau

a cessé de fonctionner
aprés |'ajout d'une carte
d’extension.

L'interruption de contréleur
réseau est partagée avec
une carte d’extension.

Dans le menu Advanced

de I'utilitaire Computer Setup,
modifiez les paramétres

de ressources de la carte.

Le contréleur réseau a
besoin de drivers pour
fonctionner.

Vérifiez que les drivers n’ont pas
été effacés accidentellement au
moment de |'installation des drivers
de la nouvelle carte d’extension.

La carte d’extension
installée est une carte
réseau et est en conflit
avec la carte réseau
intégrée.

Dans le menu Advanced

de I'utilitaire Computer Setup,
modifiez les paramétres de
ressources de la carte.
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Résolution des problémes de réseau (suite)

Probléme

Cause

Solution

Le contréleur de réseau a
cessé de fonctionner sans
cause apparente.

Les fichiers contenant les

drivers réseau sont altérés.

Réinstallez les drivers réseau
en utilisant le CD Restore Plus!

Le céble n’est pas
fixé correctement.

Assurez-vous que le cdble est bien
fixé sur le connecteur du réseau et
que son autre extrémité est reliée
au bon périphérique.

Le contréleur réseau
est défectueux.

Adressez-vous & un revendeur
ou un mainfeneur agréé.

La nouvelle carte réseau
ne s'initialise pas

La nouvelle carte réseau
est peut-étre défectueuse
ou n’est pas conforme aux
spécifications standard.

Installez une carte réseau
standard qui fonctionne ou
modifiez la séquence d'amorcage
pour démarrer & partir d'une autre
source.

Connexion au serveur
réseau impossible lors de
I"installation d’un systéme
a distance

Le contréleur réseau n’est
pas bien configuré.

Vérifiez les connexions réseau, la
présence d'un serveur DHCP et que
le serveur d'installation du systéme
a distance contient les drivers pour
la carte réseau utilisée.

L'utilitaire de
configuration systéme
signale une EEPROM

non programmée.

EEPROM non

programmée.

Adressez-vous a un revendeur
ou un mainfeneur agréé.
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Résolution des problemes de mémoire

Si vous rencontrez des problémes concernant la mémoire, consultez
le tableau ci-dessous contenant les causes fréquentes et leurs solutions.

ATTENTION : dans le cas de systémes ECC, la combinaison de modules
ECC et non-ECC n'est pas prise en charge dans les ordinateurs HP. De plus,
le systtme d’exploitation ne se charge pas.

Résolution des probléemes de mémoire

Probléeme

Cause

Solution

Le systéme ne démarre
pas ou ne fonctionne
pas correctement apres
I"installation de modules

mémoire supplémentaires.

Le type ou la fréquence
du module mémoire est
incompatible avec le
systéme ou le module
est mal installé.

Remplacez le module par |'unité
standard appropriée & |'ordinateur.

Sur certains modéles, il estimpossible
de combiner des modules mémoire

ECC et non-ECC.

Erreur d’insuffisance
mémoire.

La configuration
mémoire n’est pas
réglée correctement.

Utilisez le Gestionnaire de
périphériques pour contrdler
la configuration de la mémoire.

Vous avez dépassé

la capacité en mémoire
en exécutant une
application.

Consultez la documentation
de I"application pour déterminer
ses besoins en mémoire.

Le décompte mémoire au
cours du POST est faux.

Les modules de mémoire
ne sont pas installés
correctement.

Vérifiez que les modules de mémoire
sont correctement installés et que les
modules utilisés sont appropriés.

La carte graphique
intégrée peut utiliser
de la mémoire systéme.

Aucune mesure n’est nécessaire.
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Résolution des problémes de mémoire (suite)

Probléeme Cause Solution

Erreur de mémoire Vous avez installé Supprimez tous les programmes

insuffisante pendant trop de programmes résidents dont vous ne vous

une opération. résidents (TSR). servez pas.
Vous avez dépassé la Déterminez les besoins en mémoire
capacité en mémoire de "application ou ajoutez
disponible pour cette de la mémoire sur 'ordinateur.
application.

Le voyant d’alimentation La mémoire est 1. Retirez et remettez en place

rouge clignote cinq fois, défectueuse ou les modules DIMM. Démarrez

a une seconde d'intervalle,  mal installée. le systéme.

A .
puis s'arréte de clignoter 2. Retirez et replacez un & un les

pendant deux secondes,
et I'ordinateur émet
cing signaux sonores.

modules mémoire pour isoler
le module défaillant.

3. Remplacez les modules
mémoire de fabricants tiers
par des modules HP.

4. Remplacez la carte mére.
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Résolution des probléemes de processeur

Si vous rencontrez des problemes de processeur, consultez le tableau
ci-dessous pour connaitre leurs causes les plus fréquentes et leurs
solutions.

Résolution des problémes de processeur

Probléme Cause Solution
Vous observez de faibles Le processeur 1. Assurez-vous que |'arrivée d'air
performances. est chaud. de I'ordinateur n’est pas obstruée.

2. Assurez-vous que les ventilateurs
sont connectés et fonctionnent
correctement (certains ventilateurs
ne fonctionnement que si cela
est nécessaire).

3. Assurez-vous que le dissipateur
thermique du processeur est
installé correctement.

Le voyant d’alimentation Il ny a pas de 1. Vérifiez la présence
rouge clignote frois fois, processeur ou du processeur.

\ 1

& une seconde d'infervalle,  le processeur 2. Remettez le processeur

puis s'arréte de clignoter est mal installé.

en place.
pendant deux secondes. P
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Résolution des problemes de CD-ROM et DVD

Si vous rencontrez des problemes de CD-ROM ou de DVD, consultez
le tableau suivant pour connaitre leurs causes les plus fréquentes

et leurs solutions, ou reportez-vous a la documentation livrée avec

le lecteur en option.

Résolution des problémes de CD-ROM et de DVD

Probléeme Cause Solution
Le systtme ne démarre 'amorgage a partir Lancez |'utilitaire Computer Setup
pas & partir du lecteur d’un support amovible et activez |'option d’amorcage sur
de CD-ROM ou de DVD. est désactivé support amovible dans le menu
dans I'utilitaire Storage > Storage Options.
Computer Setup. Vérifiez que IDE CD-ROM est activé
dans Storage > Boot Order.
Le mode serveur Exécutez Computer Setup et
de réseau est activé désactivez Network Server

dans Computer Setup.  Mode dans Security >
Password Options.

Le lecteur contient un Essayez un CD amorgable

CD non amorcable. dans l'unité.

Ordre d’amorcage Lancez |'utilitaire Computer Setup et

incorrect. changez |'ordre d’amorcage dans

le menu Storage > Boot Order.

Les lecteurs de CD-ROM ou  Le lecteur est mal Reportez-vous & la documentation
DVD ne sont pas détectés  branché ou mal livrée avec le lecteur en option.
ou le driver n’est pas chargé.  configuré.
Impossible de lire un film Il se peut que le film soit  Reportez-vous & la documentation
dans le lecteur de DVD. réglé pour étre lu dans  livrée avec le lecteur DVD.

un autre pays.

Le logiciel de décodage Installez le logiciel de décodage.
n’est pas installé.

Support endommagé. Remplacez le support.

Lecture de film empéchée  Utilisez le logiciel DVD pour
par blocage parental.  supprimer le blocage parental.

Disque inséré a I'envers.  Insérez le disque correctement.
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Résolution des problémes de CD-ROM et de DVD (suite)

Probléme

Cause

Solution

Ejection du disque compact
impossible (chargeur).

Disque mal positionné
dans le lecteur.

Mettez |'ordinateur hors tension

et insérez une fine tige métallique
dans le trou d'éjection d'urgence

et poussez fermement. Tirez
doucement le tiroir hors du lecteur,
jusqu’d ce qu'il soit entiérement sorti
de l'ordinateur, puis retirez le disque.

Le lecteur de CD-ROM,

le graveur de CDRW,

le lecteur de DVD-ROM ovu
le graveur de DVD-R/RW
ne parvient pas & lire un
disque ou met trop de
temps pour démarrer.

Le disque a été
inséré a l'envers.

Réintroduisez le disque en veillant
& ce que |'étiquette soit orientée
vers le haut.

Le démarrage du lecteur
de DVD est plus lent

du fait que le type de
support (audio, vidéo)
doit étre détecté au
préalable.

Attendez au moins 30 secondes
pour laisser au lecteur de DVD-ROM
le soin de déterminer le type de
support & lire. Si le disque ne
démarre toujours pas, reportez-vous
aux autres solutions de cette section.

Le CD ou le DVD
est sale.

Nettoyez le disque & |'aide d'un kit
de nettoyage de CD disponible
dans la plupart des boutiques
d'informatique.

Windows ne

détecte pas le lecteur
de CD-ROM ou

de DVD-ROM.

1. Utilisez le Gestionnaire de
périphériques pour supprimer
ou désinstaller le périphérique
en question.

2. Redémarrez votre ordinateur
et laissez & Windows le soin
de détecter le driver de l'unité
optique.
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Résolution des problémes de CD-ROM et de DVD (suite)

Probléme

Cause

Solution

L'enregistrement de CD
audio s’avere difficile,
voire impossible.

Mauvais type de
support ou support
de piétre qualité.

1. Procédez & |'enregistrement
& une vitesse inférieure.

2. Vérifiez que le support utilisé
est adapté au lecteur.

3. Essayez d'utiliser une autre
marque de support. Il existe
en effet de grandes différences
de qualité entre les fabricants.

Résolution des problemes d’unité statique

Si vous rencontrez des problemes d’unité de mémoire de masse
statique, consultez le tableau ci-dessous pour connaitre leurs
causes les plus fréquentes et leurs solutions.

Résolution des probléemes d’unité statique

Probleme

Cause

Solution

L'unité de mémoire

de masse statique
n‘apparait pas avec

une lettre d’unité de
disque dans Windows XP.

La lettre d’unité qui
suit le dernier disque
physique n’est pas
disponible.

Changez la lettre par défaut pour
I'unité statique dans Windows XP.

L'ordinateur s’amorce sous
DOS aprés avoir créé une
unité statique amorgable.

L'unité statique
est amorcable.

Installez |'unité statique uniquement
aprés I'amor¢age du systéme
d’exploitation.
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Résolution des problemes sans diagnostic

Résolution des problemes d’accés Internet

Si vous rencontrez des problemes d’acces a I’ Internet, consultez votre
fournisseur d’acces ou reportez-vous au tableau ci-dessous connaitre
leurs causes les plus fréquentes ainsi que leurs solutions.

Résolution des problémes d’accés Internet

Probléme

Cause

Solution

Connexion Internet
impossible.

Le compte auprés du
fournisseur d’acces
Internet n’est pas
correctement défini.

Vérifiez les paramétres Internet
ou contactez votre fournisseur
de services Internet.

Le modem n’est pas
configuré correctement.

Reconnectez le modem. Vérifiez
que les connexions sont correctes
en vous servant de la documentation
d’installation.

Le navigateur Web n’est
pas configuré
correctement.

Vérifiez que le navigateur Web
est installé et configuré pour
fonctionner avec votre fournisseur
de services Internet.

Le modem céble/DSL
n’est pas branché.

Le modem céble/DSL n’est pas
branché. Le voyant d’alimentation
devrait étre allumé sur votre modem

cable/DSL.

Le service cable/DSL
n’est pas disponible
ou a été interrompu
en raison du mauvais
temps.

Réessayez plus tard ou contactez
votre fournisseur de services Internet.
(Si vous étes connecté au service
cable/DSL, le voyant “céble” sur le
modem céble/DSL doit étre allumé.)
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Résolution des problémes sans diagnostic

Résolution des problémes d’accés Internet (suite)

Probléme

Cause

Solution

Connexion Internet
impossible.
(suite)

Le cable UTP CAT5

est déconnecté.

Branchez le céble UTP CAT5 entre
le modem cable et le connecteur
RJ-45 de |'ordinateur. (Si la
connexion est bonne, le voyant
“PC” sur le modem cable/DSL

doit étre allumé.)

U'adresse IP n’est pas
bien configurée.

Confactez votre fournisseur de services
Internet pour obtenir une adresse IP
correcte.

Les Cookies sont altérés.
(Un Cookie est un petit
fichier que le serveur
Web utilise pour stocker
temporairement des
informations & I'aide
du navigateur Web. Ces
cookies permettent au
navigateur de mémoriser
certaines informations
que le serveur Web peut
récupérer par la suite.)

Dans Windows XP :

1. Sélectionnez Démarrer >
Panneau de configuration.

2. Double-cliquez sur Options
Internet.

3. Dans I'onglet Général, cliquez
sur le bouton Supprimer les
fichiers.

Impossible de lancer
automatiquement les
programmes Internet.

Pour pouvoir lancer
certains programmes,
vous devez au préalable
vous connecter d votre
fournisseur de services
Internet.

Connectez-vous a votre fournisseur
Internet, puis lancez le programme
de votre choix.
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Résolution des problemes sans diagnostic

Résolution des problémes d’accés Internet (suite)

Probléeme Cause Solution

Le téléchargement de sites  Le modem n’est pas Vérifiez que la vitesse du modem

Web prend trop de temps.  configuré correctement. et le port COM sont correctement
définis.

Dans Windows XP

1

w

. Sélectionnez Démarrer >

Panneau de configuration.

. Doublecliquez sur Systéeme.
. Cliquez sur 'onglet Mateériel.

. Dans la zone Gestionnaire

de périphériques, cliquez
sur le bouton Gestionnaire
de périphériques.

. Double<liquez sur Ports

(COM & LPT).

. Cliquez avec le bouton droit

sur le port COM utilisé par
le modem, puis cliquez sur
Propriétés

. Sous Etat du périphérique,

vérifiez que le modem fonctionne
correctement.

. Sous Utilisation du

périphérique, vérifiez
que le modem est activé.

. Si les problémes ne sont pas

résolus, cliquez sur le bouton
Résolution des problémes
et suivez les instructions
affichées.
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Résolution des problémes sans diagnostic

Résolution des problemes logiciels

La plupart des problemes logiciels surviennent pour I’une des raisons
suivantes :

L’application n’a pas été installée ou configurée correctement.

La mémoire disponible n’est pas suffisante pour exécuter
I’application.
11 existe un conflit entre des applications.

Assurez-vous que tous les gestionnaires de périphériques
nécessaires sont effectivement installés.

Si vous avez installé un systeme d’exploitation autre que
celui installé en usine, assurez-vous qu’il est pris en charge
par I’ordinateur.

Exécutez I'utilitaire Configuration Record, si vous en disposez, pour
déterminer si des modifications ont été réalisé€es sur le logiciel et
peuvent poser probleme. Pour d’autres suggestions plus générales,
reportez-vous a la section “Enregistrement de la configuration” de
ce manuel.

Si vous rencontrez des problemes de logiciel, consultez le tableau
ci-dessous pour connaitre leurs solutions.
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Résolution des problemes sans diagnostic

Résolution des problémes de logiciel

Probléeme

Cause

Solution

Le démarrage de |'ordinateur
ne se poursuit pas et aucun
logo HP n’apparait.

Une erreur d’autotest
a la mise sous tension

(POST) s’est produite.

Surveillez les signaux sonores et les
voyants a |'avant de |'ordinateur.
Reportez-vous & |’Annexe A,
“Messages d’erreur du test POST”
pour connaitre les causes possibles.

Pour plus d'informations, reportezvous
au kit de restauration ou & la
Déclaration de garantie limitée.

Le démarrage de |'ordinateur
ne se poursuit pas aprés
I'affichage du logo HP.

Des fichiers systéme
sont peut-étre
endommagés.

Utilisez la disquette de restauration
analyser le disque dur et rechercher
les erreurs.

Le message d'erreur “lllegal
Operation has Occurred”
(Une opération non valide
s'est produite) s'affiche.

Le logiciel utilisé
n'est pas certifié par
Microsoft pour votre
version de Windows.

Vérifiez que le programme est certifié
par Microsoft pour votre version

de Windows (reportez-vous &
I'emballage du programme pour
obtenir ces informations).

Les fichiers de
configuration
sont altérés.

Si cela s’avére possible, enregistrez
toutes les données, fermez tous les
programmes et redémarrez votre
ordinateur.

Assistance technique

Pour obtenir une aide ou une intervention, adressez-vous a un
revendeur agréé. Pour connaitre les coordonnées du revendeur le plus
proche de votre domicile, consultez le site http://www.compagq.fr.

% Si vous portez votre ordinateur en réparation chez un revendeur ou
mainteneur agréé, n’oubliez pas de lui communiquer les mots de
passe de configuration et de mise sous tension, si vous les avez définis.

% Pour appeler I’assistance technique, reportez-vous aux numéros
indiqués sur la carte de garantie ou au guide intitulé Support
Telephone Numbers sur le CD Documentation.
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Messages d’erreur du test POST

Cette annexe répertorie les codes d’erreur, les messages d’erreur et
les différents signaux lumineux et sonores que vous pourrez rencontrer
lors de I’autotest de mise sous tension (POST) ou apres le redémarrage
de I’ordinateur. Elle indique également la cause probable de I’erreur
et les étapes a suivre pour y remédier.

La fonction POST Message Disabled (Messages POST désactivés)
supprime la plupart des messages systeme pendant I’autotest POST,
tels que le décompte de la mémoire et les messages autres que les
messages d’erreur. Si une erreur POST se produit, I’écran affiche

le message d’erreur correspondant. Pour passer manuellement en
mode Messages POST activés au cours du POST, appuyez sur
n’importe quelle touche (sauf la touche F10 ou F12). Le mode

par défaut est Messages POST désactivés.

La vitesse de chargement du systeme d’exploitation par 1’ordinateur
et I’étendue des tests dépendent de la sélection du mode POST.

Le processus de démarrage rapide (QuickBoot) ne procede pas a tous
les tests au niveau du systéme : ceux qui concernent la mémoire, par
exemple, sont exclus. Le démarrage FullBoot exécute tous les tests
systéme reposant sur la ROM et dure plus longtemps.

Vous pouvez activer le démarrage complet (Full Boot) de sorte

qu’il s’exécute a des intervalles réguliers compris entre 1 et 30 jours.
Pour définir ces intervalles, reconfigurez I’ordinateur avec 1’option
Full Boot Every x Days (Démarrage complet tous les xx jours), via
I'utilitaire Computer Setup.

% Pour plus d’informations sur Computer Setup, consultez le Manuel
de lutilitaire Computer Setup (F10) sur le CD Documentation.
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Messages d’erreur du test POST

Codes numériques et messages texte du test POST

S

La présente section décrit les erreurs de 1’autotest a la mise sous
tension (POST) auxquelles des codes numériques sont associés.
Elle comprend également quelques messages de texte susceptibles

d’apparaitre lors de ce test.

L’ordinateur émet un signal sonore unique lorsqu’un message

POST est affiché a I’écran.

Codes numériques et messages textuels du test POST

Code/message

Cause probable Action recommandée

101-Option ROM
Checksum Error
(erreur total de
contréle ROM)

Total de contréle de la 1.

ROM option du systéme 2
ou de la carte d’extension.

Vérifiez que la ROM est correcte.

. Réécrivez la ROM si nécessaire.

. Si vous avez récemment ajouté une

carte d’extension, retirez-la et vérifiez
si le probléme persiste.

. Effacez la CMOS. (Reportez-vous

a I'’Annexe B, “Protection par mot
de passe et réinitialisation de la
mémoire CMOS.”)

. Si le message ne réapparait pas,

il se peut qu'il y ait un probléme
au niveau de la carte d’extension.

. Remplacez la carte mére.

102-System Board
Failure (défaillance
de la carte mére)

DMA ou horloges. 1.

Effacez la CMOS. (Reportez-vous
a I'’Annexe B, “Protection par mot
de passe et réinitialisation de la

mémoire CMOS.”)

. Retirez les cartes d’extension.

. Remplacez la carte meére.
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

103-System Board
Failure (défaillance
de la carte mére)

DMA ou horloges

1.

Effacez la CMOS. (Reportez-vous
a I'’Annexe B, “Protection par mot
de passe et réinitialisation de la

mémoire CMOS.”)

. Retirez les cartes d’extension.

. Remplacez la carte meére.

110-Out of Memory
Space for Option
ROMs (espace
mémoire insuffisant
pour les ROM
d’options)

Une carte d’extension
PCI récemment ajoutée
contient une ROM
d’options de faille trop
élevée pour le chargement

pendant POST.

. Si vous avez récemment ajouté une

carte d’extension PCl, retirez-la et
vérifiez si le probléme persiste.

. Dans Computer Setup, désactivez

I'option Advanced > Device
Options > NIC PXE Option
ROM Download, pour empécher
le chargement pendant le POST de la
ROM d’options PXE pour carte réseau
interne. Vous libérerez ainsi plus de
mémoire pour la ROM d'options d'une
carte d’extension. La ROM d’options
PXE est utilisée pour I'amorcage &
partir d'un serveur PXE via la carte
réseau.

. Activez |'option ACPI/USB Buffer @

Top of Memory dans Computer Setup.

150-SafePost Active
(SafePost activé)

Une carte d’extension
PCl ne répond pas.

. Redémarrez |'ordinateur.
. Désactivez SafePost.

. Si la carte d’extension ne répond

pas, remplacez-la.
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

162-System Options
Not Set (options
systtme non définies)

Configuration incorrecte.

La pile de 'horloge
temps réel (RTC) doit
éventuellement étre
remplacée.

Exécutez Computer Setup pour vérifier
la configuration des périphériques dans
Advanced > Onboard Devices.

Réglez la date et I'heure depuis le
Panneau de configuration. Si le
probléme persiste, remplacez la pile HTR.
Reportez-vous au Manuel de référence
du matériel sur le CD Documentation
pour connaitre la procédure d'installation
d’une nouvelle pile ou adressez-vous

a votre revendeur agréé pour effectuer
le remplacement.

163-Time & Date
Not Set (heure et
date non définies)

Heure ou date invalide
dans la mémoire de
configuration.

La pile de I'horloge
temps réel (RTC) doit
éventuellement étre
remplacée.

Réglez la date et I'heure dans le Panneau
de configuration (vous pouvez également
utiliser Computer Setup). Si le probléme
persiste, remplacez la pile HTR.
Reportez-vous au Manuel de référence
du matériel sur le CD Documentation
pour connaitre la procédure d'installation
d’une nouvelle pile ou adressez-vous &
votre revendeur agréé pour effectuer le
remplacement.

Le cavalier CMOS
n’est pas positionné
correctement.

Le cas échéant, vérifiez le positionnement

du cavalier de la CMOS.
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

164-Memory Size
Error (erreur de taille
mémoire)

La taille mémoire a changé
depuis le dernier
démarrage (ajout ou

suppression de mémoire).

Appuyez sur la touche F1 pour enregistrer
le changement de mémoire.

Configuration incorrecte
de la mémoire.

. Exécutez Computer Setup ou les

utilitaires Windows.

. Assurez-vous, le cas échéant, que

le ou les modules de mémoire sont
installés correctement.

. Si de la mémoire d’un fabricant tiers

a été ajoutée, effectuez le test sur
de la mémoire HP uniquement.

. Contrélez le type du module

de mémoire.

201-Memory Error
(erreur de mémoire)

Erreur de mémoire

vive (RAM)

. Exécutez Computer Setup ou les

utilitaires Windows.

. Vérifiez que les modules mémoire

sont correctement installés.

. Contrélez le type du module mémoire.

. Retirez et replacez un & un les

modules mémoire pour isoler
le module défaillant.

. Remplacez le(s) module(s) mémoire

défaillant(s).

. Si I'erreur persiste, aprés le

remplacement des modules
mémoire, remplacez la carte mére.

202-Memory
Type Mismatch
(incompatibilité de
types de mémoire)

Les modules mémoire
ne sont pas compatibles
entre eux.

Remplacez les modules par des modules
compatibles.
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

213-Incompatible
DIMM Module in
DIMM Socket(s)

X, X, ... (module
DIMM incompatible

dans le ou les

Le module mémoire du
support décrit dans le
message d'erreur n’intégre
pas des données SPD
essentielles ou est
incompatible avec

1.
2.
3.

Contrélez le type du module mémoire.
Essayez un autre support de mémoire.

Remplacez le module DIMM par un
module conforme aux normes SPD.

supports DIMM le chipset.

X, X,..)

214DIMM Une erreur spécifique 1. Contrélez le type du module mémoire.
Configuration s'est prOdlf”e dans un . 2. Essayez un autre support de mémoire.
Warning module mémoire installé

(avertissement de
configuration DIMM)

dans le support identifié.

. Remplacez le module de mémoire

si le probléme persiste.

219-ECC Memory
Module Detected
ECC Modules not
supported on this
Platform (module
mémoire ECC
détecté, la mémoire
ECC n’est pas prise
en charge sur cette
plate-forme)

Les modules mémoire
ajoutés récemment
prennent en charge la
correction d’erreur ECC.

. Si vous avez récemment ajouté de

la mémoire, retirez-la et vérifiez si
le probléme persiste.

. Consultez la documentation de

I'ordinateur & propos de la compatibilité
des types de mémoire.

301-Keyboard Error
(erreur de clavier)

Erreur du clavier.

. Eteignez |'ordinateur et rebranchez

le clavier.

. Vérifiez qu'il ne manque aucune

broche au connecteur et qu’elles
ne sont pas pliées.

. Assurez-vous qu’aucune des touches

n’est enfoncée.

. Remplacez le clavier.

303-Keyboard
Controller Error
(erreur de contréleur
de clavier)

Carte E/S du contrdleur
de clavier.

. Eteignez I'ordinateur et rebranchez

le clavier.

. Remplacez la carte mére.
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

304-Keyboard or
System Unit Error
(erreur de clavier
ou d'unité systéme)

Erreur du clavier.

1. Eteignez |'ordinateur et rebranchez
le clavier.

2. Assurez-vous qu’aucune des touches
n’est enfoncée.

3. Remplacez le clavier.

4. Remplacez la carte mére.

404-Parallel Port
Address Conflict
Detected (détection
d’un conflitd’adresse
de port paralléle)

Les ports externe et interne
sont tous deux affectés
au port paralléle X.

p—

. Retirez toute carte d’extension de port
paralléle éventuelle.

2. Effacez la CMOS. (Reportez-vous
a I'’Annexe B, “Protection par mot
de passe et réinitialisation de la
mémoire CMOS.”)

3. Reconfigurez les ressources de
la carte et/ou lancez I'utilitaire
Computer Setup.

410-Audio Interrupt
Conflict (conflit
d'interruption audio)

L'adresse IRQ est en conflit
avec une autre unité.

Exécutez Computer Setup et redéfinissez
les IRQ dans Advanced > Onboard
Devices.

411-Network
Interface Card

l'adresse IRQ est en conflit
avec une autre unité.

Exécutez Computer Setup et redéfinissez
les IRQ dans Advanced > Onboard

Interrupt Conflict Devices.
(conflitd’interruption
de carte interface
réseau)
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

501-Display Adapter
Failure (panne
d’adaptateur écran)

Contréleur d'affichage
graphique.

1.

2.

3.

4.

Replacez la carte graphique dans
son connecteur (le cas échéant).

Effacez la CMOS. (Reportez-vous
a I'’Annexe B, “Protection par mot

de passe et réinitialisation de la
mémoire CMOS.”)

Vérifiez que le moniteur est connecté
et allumé.

Remplacez la carte graphique
(si c'est possible).

510-Splash Screen
image corrupted
(image de I'écran
de démarrage
altérée)

L'image de I'écran de
démarrage comporte
des erreurs.

Installez la derniére version de ROMPaq
pour restaurer |'image.

511-CPU, CPUA,
or CPUB Fan not
Detected (ventilateur
de processeur non
détecté)

Le ventilateur du
processeur est
déconnecté ou présente
un dysfonctionnement.

N

. Repositionnez le ventilateur

du processeur.

. Vérifiez que le céble du ventilateur

est bien branché.

. Remplacez le ventilateur.

512-Chassis, Rear
Chassis, or Front
Chassis Fan not
Detected
(ventilateurs du
chassis, avant ou
arriére non détectés)

Le ventilateur du chassis,
de I'avant ou de 'arriére
du chassis n’est pas
connecté ou ne
fonctionne pas.

. Repositionnez les ventilateurs

du chéssis.

. Vérifiez que le céble du ventilateur

est bien branché.

. Remplacez le ventilateur de chéssis

défaillant.

514-CPU or Chassis
Fan not Detected
(ventilateur de
processeur ou de
chéssis non détecté)

Le ventilateur du
processeur ou du chassis
est déconnecté ou présente
un dysfonctionnement.

. Repositionnez le ventilateur

du processeur ou du chéssis.

. Vérifiez que le céble du ventilateur

est bien branché.

. Remplacez le ventilateur du processeur

ou du chassis.
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

601-Diskette
Controller Error
(erreur du contréleur
de disquette)

Les circuits du contréleur
de disquette ou de |'unité
de disquette sont
incorrects.

1.
2.
3.

Exécutez Computer Setup.
Contrélez et/ou remplacez les cébles.

Effacez la CMOS. (Reportez-vous
a I'’Annexe B, “Protection par mot
de passe et réinitialisation de la

mémoire CMOS.")

. Remplacez I'unité de disquette.

. Remplacez la carte mére.

605-Diskette Drive
Type Error (erreur
type unité de
disquette)

Incompatibilité du type
d'unité.

N — O N

. Exécutez Computer Setup.

. Débranchez tous les autres

périphériques de contréleur
de disquette (unités de
sauvegarde sur cartouche).

. Effacez la CMOS. (Reportez-vous

a I'’Annexe B, “Protection par mot
de passe et réinitialisation de la

mémoire CMOS.”)

610-External
Storage Drive
Failure (panne unité
externe de stockage
de données)

L'unité externe de
sauvegarde sur cartouche
n’est pas connectée.

Réinstallez I'unité de sauvegarde
sur cartouche ou appuyez sur F1
pour permettre au systéme de se
reconfigurer sans I'unité.

611-Secondary
Floppy Port Address
Assignment Conlflict
(conflit d’affectation
d’adresse au port
d'unité de disquette
secondaire)

Erreur de configuration.

Exécutez Computer Setup pour vérifier
la configuration des périphériques dans
Advanced > Onboard Devices.

660-Display cache
is defected unreliable
(cache d'affichage
considéré comme
non fiable)

Le cache d'affichage
intégré du contréleur
graphique ne fonctionne
pas correctement et va
étre désactivé.

Remplacez la carte systéme si une
dégradation minime de la qualité
graphique vous pose probléme.

Manvuel de résolution des probléemes

www.hp.com

A-9



Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

912-Computer Cover
Has Been Removed
Since Last System
Start Up (le capot
de I'ordinateur a
été ouvert depuis le
dernier démarrage
de I'ordinateur)

Le capot de |'ordinateur
a été ouvert depuis

le dernier démarrage
de |'ordinateur.

Aucune mesure n’est nécessaire.

914-Hood Lock Coil
is not Connected

(le solénoide de
verrouillage du capot
n’est pas connecté)

Le mécanisme du verrou
Smart Cover manque
ou n’est pas connecté.

1. Reconnectez ou remplacez
le mécanisme de verrouillage
du capot.

2. Refixez ou remplacez le cable
du mécanisme de verrouillage.

916-Power Button
Not Connected
(bouton de mise
sous tension non
connecté)

Le cdble du bouton
de mise sous tension
est débranché ou mal

connecté & la carte mére.

Reconnectez ou remplacez le céble
du bouton de mise sous tension.

917-Front Audio
Not Connected
(haut-parleur avant
non connecté)

Le cable du haut-parleur
avant est débranché ou
mal connecté & la carte
mere.

Reconnectez ou remplacez le cable
du hautparleur.

918-Front USB Not
Connected (USB

avant non connecté)

Le cable de port USB
avant est débranché
ou mal connecté a la
carte mere.

Reconnectez ou remplacez le cable
de connexion USB.

919-Multi-Bay Riser
not Connected (fond
de panier Multibay
non connecté)

La carte de fond de
panier a été retirée ou
n’'a pas été repositionnée
correctement.

Réinsérez la carte de fond de panier.

www.hp.com
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

1151-Serial Port A
Address Conflict
Detected (détection
d’un conflitd’adresse
de port série A)

Les ports série externe
et interne sont tous deux

affectés & COMI.

1.

Retirez toute carte d’extension de port
série éventuelle.

. Effacez la CMOS. (Reportez-vous

a I'’Annexe B, “Protfection par mot

de passe et réinitialisation de la
mémoire CMOS.”)

. Reconfigurez les ressources de la carte

et/ou exécutez Computer Setup ou les
utilitaires Windows.

1152-Serial Port B
Address Conflict
Detected (détection
d’un conflitd’adresse
au port série B)

Les ports série externes
et internes sont fous deux

affectés & COM2.

. Retirez toute carte d’extension de port

série éventuelle.

. Effacez la CMOS. (Reportez-vous

a I'’Annexe B, “Protection par mot
de passe et réinitialisation de la

mémoire CMOS.”)

. Reconfigurez les ressources de la carte

et/ou exécutez Computer Setup ou les
utilitaires Windows.

1155- Serial Port
Address Conflict
Detected (détection
d’un conflitd’adresse
de port série)

Les ports série externe
et interne sont tous deux
affectés au méme IRQ.

. Retirez toute carte d’extension de port

série éventuelle.

. Effacez la CMOS. (Reportez-vous

a I'’Annexe B, “Protection par mot
de passe et réinitialisation de la

mémoire CMOS.”)

. Reconfigurez les ressources de la carte

et/ou exécutez Computer Setup ou les
utilitaires Windows.

Manvuel de résolution des probléemes
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

1201-System Audio
Address Conflict
Detected (détection
d’un conflitd’adresse
audio systéme)

'adresse IRQ du
périphérique est en
conflit avec un autre
périphérique.

Exécutez Computer Setup et redéfinissez
les IRQ dans Advanced > Onboard
Devices.

1202- MIDI Port
Address Conflict
Detected (détection
d’un conflitd’adresse

de port MIDI)

'adresse IRQ du
périphérique est en
conflit avec un autre

périphérique.

Exécutez Computer Setup et redéfinissez
les IRQ dans Advanced > Onboard
Devices.

1203- Game Port
Address Conflict
Detected (détection
d’un conflitd’adresse
de port jeu)

'adresse IRQ du
périphérique est en
conflit avec un autre
périphérique.

Exécutez Computer Setup et redéfinissez
les IRQ dans Advanced > Onboard
Devices.

1720-SMART Hard
Drive detects
imminent failure

(le contréleur
SMART de disque
dur détecte une
panne imminente)

Le disque dur est sur

le point de tomber en
panne. (certains disques
durs sont dotés d'un
microprogramme de
réparation des messages
de panne erronés).

1. Vérifiez que le disque dur émet un
message de panne correct. Lancez
Computer Setup et exécutez le test
du systéme de protection des unités
via Storage > DPS Self-test.

2. Utilisez le microprogramme de
correction, si nécessaire. (Disponible
sur le site www.hp.fr/support.)

3. Sauvegardez le contenu du disque
dur et remplacezle.

www.hp.com
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message Cause probable Action recommandée
1785-Multibay (pour ['option 1. Vérifiez que I'option Multibay est
incorrectly installed  Multibay,/systémes connectée comme périphérique O
(installationincorrecte  non USDT) sur le cable IDE.

du MultiBay)

1. Les cables plats de
I'option Multibay ne
sont pas correctement
branchés.

2. Périphérique Multibay
non inséré
correctement.

3. Présence d’une
disquette Multibay.

w

. Vérifiez qu’aucun autre périphérique

est connecté au méme cable IDE.

. Vérifiez que les deux extrémités des

cdbles plats IDE et Multibay sont
correctement branchés.

. Vérifiez que le périphérique Multibay

est correctement inséré dans son
compartiment.

. Vérifiez qu'il n'y a pas de disquette

Multibay (les unités de disquette
Multibay ne sont pas prises en
charge par I'option Multibay).

(systemes intégrés
Multibay,/USDT)
1. Périphérique
Multibay non
inséré correctement.

2. Fond de panier
Multibay non
inséré correctement.

. Vérifiez que le périphérique Multibay

est correctement inséré dans son
compartiment.

. Vérifiez que la carte de fond de

panier est correctement insérée.

1794-Inaccessible
devices attached

to SATA 1 and/or
SATA 3
(périphériques
inaccessibles
connectés a SATA 1
et/ou SATA 3)

(systémes avec
4 ports SATA)

Un périphérique est
connecté au port SATA 1
et/ou au port SATA 3.
Les périphériques
connectés & ces deux
connecteurs seront
inaccessibles lorsque
“SATA Emulation”

est définie comme
“Combined IDE
Controller” dans
Computer Setup.

. Sous Windows 2000 ou XP, définissez

“SATA Emulation” comme “Separate
IDE Controller” dans Computer Setup.

. Pour les autres systémes d’exploitation,

placez les périphériques affectés sur
SATA 0 ou SATA 2 (si disponibles).

. Retirez les périphériques affectés

de SATA 1 et SATA 3.

Manvuel de résolution des probléemes
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable

Action recommandée

1794-Inaccessible
device attached

to SATA 1
(périphérique
inaccessible connecté

a SATA 1)

(systémes avec
2 ports SATA)

Un périphérique est
connecté au port SATA 1.
Tout périphérique
connecté a ce connecteur
sera inaccessible tant
que “SATA Emulation”
est définie comme
“Combined IDE
Controller” dans
Computer Setup.

1.

Sous Windows 2000 ou XP,
définissez “SATA Emulation”
comme “Separate IDE Controller”
dans Computer Setup.

. Pour les autres systémes d’exploitation,

placez le périphérique affecté sur
SATA O (si disponible).

. Retirez le périphérique affecté

de SATA 1.

1796-SATA Cabling
Error (erreur de

Un ou plusieurs
périphériques SATA

Vérifiez que les connecteurs SATA sont
utilisés en ordre croissant. Pour un seul

cdblage SATA) ne sont pas correctement  périphérique, utilisez SATA 0. Pour deux
connectés. Pour un périphériques, utilisez SATA O et SATA 1.
fonctionnement optimal,  Pour trois périphériques utilisez SATA O,
les connecteurs SATA O SATATlet SATA 2.
et SATA 1 doivent étre
utilisés avant les
connecteurs SATA 2
et SATA 3.
1800-Temperature La température interne 1. Vérifiez que les aérations de
Alert (alerte de est trop élevée. I'ordinateur ne sont pas obstruées
température) et que le ventilateur du processeur

fonctionne.

2. Contrélez la vitesse du processeur.
3. Remplacez le processevur.
4. Remplacez la carte mére.
1801-Microcode Le processeur n’est pas 1. Mettez le BIOS & niveau.
Patch Error (Erreur pris en charge par le 2. Remplacez le processeur.

de microcode)

BIOS de la ROM.

1998-Master Boot
Record has been
lost (Perte de la
sécurité MBR)

La copie de sauvegarde
du MBR est altérée.

Lancez |'utilitaire Computer Setup
et enregistrez le MBR du disque
amorcable actuel.
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message Cause probable Action recommandée
1999-Master Boot Le MBR actuel ne Agissez avec la plus grande prudence.
Record has changed  correspond pas & la Le MBR a été mis a jour dans le cadre

(La sécurité MBR

a été modifiée)

copie de sauvegarde
enregistrée.

d’activités normales de maintenance
du disque (gestionnaire de disque,
fdisk ou format).

Dans de telles conditions, le

remplacement de la copie de

sauvegarde du MBR précédemment

enregistrée peut enfrainer une

perte de données.
Si vous étes certain que la modification
du MBR est involontaire ou indésirable
(elle est par exemple due & un virus),
lancez I'utilitaire Computer Setup et
restaurez la copie de sauvegarde du MBR.
Sinon, lancez |'utilitaire Computer Setup
et désactivez la sécurité MBR ou enregistrez
la sécurité MBR du disque amorgable actuel.

2000-Master Boot
Record Hard Drive
has changed

(Le disque dur de
la sécurité MBR

a changé)

Le disque dur amorgable
actuel différe de celui
qui était présent lors

de I'activation de la
sécurité MBR.

Lancez |'utilitaire Computer Setup et
désactivez la sécurité MBR ou enregistrez
le MBR du disque amorcable actuel.

Invalid Electronic
Serial Number
(numéro de série
électronique non
valide)

Le numéro de série

électronique a été altéré.

1. Exécutez Computer Setup. Si le champ
contient déja des données ou nautorise
pas la saisie d'un numéro de série,
téléchargez depuis le site
www.compagq_.fr et exécutez

SP5572.EXE SNZERO.EXE).

2. Exécutez I'utilitaire Computer Setup
et essayez d’entrer le numéro de
série sous Security, System ID, puis
enregistrez les modifications.
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Messages d’erreur du test POST

Codes numériques et messages textuels du test POST (suite)

Code/message

Cause probable Action recommandée

Mode serveur
de réseau activé
et aucun clavier

Panne de clavier pendant
le mode serveur de réseau.

1. Eteignez |'ordinateur et rebranchez
le clavier.

2. Vérifiez qu'il ne manque aucune

connecte broche au connecteur et qu’elles
ne sont pas pliées.
3. Assurez-vous qu’aucune des touches
n’est enfoncée.
4. Remplacez le clavier.
Parity Check 2 Erreur de RAM de parité  Exécutez Computer Setup ou les utilitaires

(test de parité 2)

Windows.

Le systéme ne
démarre pas sans
ventilateur

Pas de ventilateur
installé sur le processeur
ou déconnecté du
chassis VSFF.

1. Ouvrez le capot, appuyez sur
le bouton d’alimentation et vérifiez
que le ventilateur du processeur tourne.
Si le ventilateur du processeur ne
tourne pas, vérifiez que son cable
est connecté & la carte mére. Vérifiez
que le ventilateur est correctement mis
en place.

2. Si le ventilateur est correctement
branché et mis en place, mais
ne tourne pas, remplacez-le.
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Messages d’erreur du test POST

Voyants du clavier et du panneau avant
et codes sonores pour le diagnostic POST

Cette section couvre les codes des voyants du panneau avant ainsi que
les codes sonores susceptibles de se présenter lors de ’autotest a la
mise sous tension, et qui ne sont pas nécessairement liés & un code
d’erreur ou a un message textuel.

Si vous voyez des voyants clignoter sur un clavier PS/2, observez
le clignotement des voyants du panneau avant de I’ordinateur et
reportez-vous au tableau ci-dessous pour déterminer leur signification.

SN

Les actions recommandées sont indiquées dans 1’ordre dans lequel
elles doivent étre accomplies.

SN

Diagnostics a I’aide des voyants du panneau avant
et des codes sonores

Activité Signaux Cause possible Action recommandée
sonores
Voyant Aucune Ordinateur Aucune.
d’alimentation allumé.
vert allumé.
Le voyant Aucune Ordinateur en Aucune action requise. Appuyez sur

d’alimentation
vert clignote
toutes les

deux secondes.

mode Suspend
to RAM (certains
modéles
uniquement)

ou en mode
Suspend normal.

une touche quelconque ou déplacez
la souris pour sortir du mode Suspend.

Manvuel de résolution des probléemes
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Messages d’erreur du test POST

Diagnostics a l’aide des voyants du panneau avant
et des codes sonores (suite)

Activité Signaux Cause possible Action recommandée
sonores
Le voyant 2 La protection . Vérifiez que les aérations de
d’alimentation thermique du I'ordinateur ne sont pas obstruées
rouge clignote processeur est et que le ventilateur du processeur
deux fois, & activée : fonctionne.
3?_6 seconde Il se peut quun . Ouvrez le capot, appuyez sur le
intervalle, ventilateur soit bouton d’alimentation et vérifiez
SU'SF‘ arrete bloqué ou ne que le ventilateur du processeur
e Cd'Q”Ofer tourne pas. tourne. Si le ventilateur du
sen ant q ou processeur ne tourne pas, vérifiez
eux secondes. Il se peut que que son cdble est connecté &
le bloc dissipateur la Cﬂ”? meret. Verlfletz quet |e'
thermique,/ventilat ven ||a eur est correctement mis
: en place.
eur ne soit pas P
correctement fixé . Si le ventilateur est correctement
sur le processeur. branché et mis en place, mais
ne fonctionne pas, remplacez-le.
. Remettez le dissipateur thermique
du processeur en place et
vérifiez que le ventilateur
est convenablement fixé.
. Adressez-vous & un revendeur
ou un mainteneur agréé.
Le voyant 3 Processeur non . Vérifiez la présence

d’alimentation
rouge clignote
trois fois, &
une seconde
d’intervalle,
puis s'arréte
de clignoter
pendant

deux secondes.

installé (il ne
s'agit pas
d’une indication
de mauvais
fonctionnement
du processeur).

du processeur.

. Remettez le processeur en place.
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Messages d’erreur du test POST

Diagnostics a l’aide des voyants du panneau avant
et des codes sonores (suite)

Activité Signaux Cause possible Action recommandée

sonores
Le voyant 4 Alimentation 1. Ouvrez le capot et vérifiez que
d’alimentation défaillante le c&ble d’alimentation & quatre
rouge clignote (en surcharge). conducteurs est bien connecté

quatre fois, &
une seconde
d’intervalle,

puis s'arréte de
clignoter pendant
deux secondes.

d la carte mére.

2. Assurezvous que le probléme n’est
pas causé par un périphérique en
retirant TOUS les périphérique
installés (disque dur, unité de
disquette, unité optique et cartes
d’extension). Démarrez le systéme.
Si le systéme effectue |'autotest
a la mise sous tension (POST),
éteignez |'ordinateur et replacez
un & un les périphériques en
recommencant la procédure jusqu’é
ce que la défaillance se produise.
Remplacez le périphérique qui
provoque la défaillance. Continuez
& remettre les périphériques un &
un pour vérifier qu'ils fonctionnent
tous correctement.

3. Remplacez I'alimentation.

4. Remplacez la carte mére.

Le voyant 5
d’alimentation

rouge clignote

cing fois, &

une seconde
d’intervalle,

puis s'arréte

de clignoter

pendant

deux secondes.

Erreur de mémoire 1. Retirez et remettez en place
prévidéo. les modules DIMM. Démarrez
le systéme.

2. Retirez et replacez un & un
les modules mémoire pour
isoler le module défaillant.

3. Remplacez les modules mémoire
de fabricants tiers par des
modules HP.

4. Remplacez la carte mére.
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Messages d’erreur du test POST

Diagnostics a l’aide des voyants du panneau avant

et des codes sonores (suite)

Activité Signaux Cause possible Action recommandée
sonores

Le voyant 6 Erreur graphique  Systémes avec carte graphique :

d °|'me?t°f'°” prévidéo. 1. Retirez et remettez la carte

rgugf;g clignote graphique en place. Démarrez

sixfois, a le systéme.

une seconde )

d'intervalle, 2. Remplacez la carte graphique.

puis s'arréte
de clignoter
pendant

deux secondes.

3. Remplacez la carte mére.
Dans le cas de systémes avec carte
graphique intégrée, remplacez la
carte mére.

Remplacez la carte mére.

Le voyant 7 Carte mére
d’alimentation défectueuse
rouge clignote (détection d'une
sept fois, & défaillance ROM
une seconde avant vidéo).
d’intervalle,

puis s'arréte

de clignoter

pendant

deux secondes.

Le voyant 8 Total de contréle
d’alimentation de la ROM
rouge clignote incorrect.

huit fois, &

une seconde

d’intervalle,

puis s'arréte de
clignoter pendant
deux secondes.

1. Réécrivez la ROM a 'aide de la
disquette ROMPagq. Voir la section
“Réécriture de la ROM dans
le Manuel de supervision des
ordinateurs de bureau disponible
sur le CD Documentation.

2. Remplacez la carte mére.
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Messages d’erreur du test POST

Diagnostics a l’aide des voyants du panneau avant
et des codes sonores (suite)

Activité Signaux Cause possible Action recommandée
sonores
Le voyant 9 Le systéme se met 1. Vérifiez que le sélecteur de tension,
d’alimentation sous tension, mais situé a |'arriére de I'alimentation
rouge clignote ne s'amorce pas. (sur certains modéles), est réglé
neuf fois, & sur la tension appropriée. Le choix
une seconde de la tension dépend de la tension
d'infervalle, secteur de votre pays.
A

puis s‘arrste 2. Remplacez la carte mére.
de clignoter 3. Remol |
pendant . Remplacez le processeur.
deux secondes.
Le voyant 10 Carte d’option 1. Vérifiez toutes les cartes graphiques
d’alimentation défectueuse. en les retirant une a une (dans
rouge clignote le cas de plusieurs cartes) et en
dix fois, & redémarrantle systéme pour vérifier
une seconde si le probléme est résolu.

-
d '.merG”AG' 2. Si vous identifiez une carte
SUISI§ arrete défectueuse, retirez-la et

e clignoter remplacez-la par une nouvelle.
pendant | | .
deux secondes. 3. Remplacez la carte mére.
Le systéme ne Aucune Impossible de Appuyez sur le bouton d’alimentation

démarre pas et
les voyants ne
clignotent pas.

mettre le systéme
sous tension.

et maintenezle enfoncé pendant
moins de 4 secondes. Si le voyant
vert du disque dur s'allume :

1.

2.

3.

Vérifiez que le sélecteur de tension,
situé & I'arriére de I'alimentation,
Retirez les cartes d’extension une
& une, jusqu’a ce que le voyant
de tension auxiliaire de 3 V de
la carte mére s’allume.

Remplacez la carte mére.
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Diagnostics a l’aide des voyants du panneau avant
et des codes sonores (suite)

Activité

Signaux
sonores

Cause possible

Action recommandée

Le systéme ne
démarre pas et
les voyants ne
clignotent pas.
(suite)

Aucune
(suite)

Impossible de
mettre le systéme
sous fension.

(suite)

Oou

Appuyez sur le bouton d’alimentation
et maintenez-le enfoncé pendant
moins de 4 secondes. Si le voyant
vert du disque dur ne s’allume pas :

1.

Vérifiez que |'ordinateur est
branché sur une prise secteur
en parfait état de marche.

. Ouvrez le capot et vérifiez que

le cable du bouton d’alimentation
est correctement connecté a la
carte mére.

. Vérifiez que les deux cdbles

d’alimentation sont correctement
connectés & la carte mére.

. Vérifiez que le voyant de tension

auxiliaire de 3 V est allumé sur
la carte mére. Si le voyant est

allumé, remplacez le céble du

bouton d’alimentation.

. Si le voyant de tension auxiliaire

de 3 V n’est pas allumé,
remplacez |'alimentation.

. Remplacez la carte mére.
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Protection par mot de passe et
réinitialisation de la mémoire CMOS

Votre ordinateur offre des fonctions de protection par mot de passe,
paramétrables a partir du menu de I’utilitaire Computer Setup.

Deux types de protection par mot de passe sont disponibles a partir du
menu de I’utilitaire Computer Setup : le mot de passe de configuration
et le mot de passe de mise sous tension. Lorsque vous établissez seulement
un mot de passe de configuration, tout utilisateur peut accéder a toutes
les informations de I’ ordinateur, a I’exception de Computer Setup.
Lorsque vous définissez uniquement un mot de passe de mise sous
tension, celui-ci est nécessaire pour accéder a I'utilitaire Computer Setup
et a toutes les autres données de 1’ ordinateur. Si vous créez les deux
mots de passe, seul le mot de passe de configuration vous donne acces
a Computer Setup.

Lorsque les deux mots de passe sont définis, le mot de passe
de configuration peut étre utilisé a la place du mot de passe de
mise sous tension pour accéder a I’ordinateur. Cette option est
particulierement utile pour I’administrateur de réseau.

Si vous oubliez le mot de passe de votre ordinateur, vous pouvez
I’effacer de deux manieres pour avoir acces aux données de 1’ordinateur :

B En réinitialisant le cavalier de mot de passe.
B En utilisant le bouton d’effacement de 1a CMOS.

fi ATTENTION : le fait d"appuyer sur le bouton de la CMOS réinitialisera
toutes les valeurs CMOS et effacera toutes les informations personnalisées,
telles que les mots de passe, numéros d’inventaire et réglages spéciaux.
Il convient de sauvegarder les valeurs CMOS de |'ordinateur avant leur
réinitialisation, pour le cas ou elles devraient étre restaurées ultérieurement.
Cette sauvegarde s'exécute facilement & I'aide de Computer Setup.
Pour plus d'informations & ce sujet, reportez-vous au Manuel de ['utilitaire
Computer Setup (F10) sur le CD Documentation.
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Protection par mot de passe et réinitialisation de la mémoire CMOS

Réinitialisation du cavalier de mot de passe

A\
A\

AN

Pour désactiver les fonctions de mots de passe de mise sous tension et de
configuration, ou pour effacer ces mots de passe, procédez comme suit :

1. Arrétez le systeéme d’exploitation selon la procédure d’arrét standard,
mettez |’ordinateur et tous les périphériques externes hors tension,
puis débranchez le cordon d’alimentation de la prise secteur.

2. Le cordon d’alimentation étant débranché, appuyez a nouveau sur
le bouton de mise sous tension pour éliminer toute énergie résiduelle.

AVERTISSEMENT : ofin de réduire les risques de blessures consécutives
& une décharge électrique ou au contact avec des surfaces chaudes,
assurez-vous que le cordon d’alimentation est débranché et laissez les
composants refroidir avant de les toucher.

ATTENTION : lorsque |'appareil est branché sur le secteur, la carte
mére est toujours alimentée, méme lorsque I'unité est éteinte. Si le cordon
d’alimentation n’est pas débranché, le systéme risque d'étre endommagé.

ATTENTION : ['électricité statique peut endommager les composants
électroniques de |'ordinateur ou de I'équipement en option. Il est conseillé
de toucher un objet métallique relié & la terre avant de commencer
I'installation. Pour plus d’informations & ce sujet, reportez-vous au
manvuel Informations sur la sécurité et les réglementations figurant sur

le CD Documentation.

3. Retirez le panneau d’acces ou capot de I’ordinateur.

4. Repérez le cavalier et son support.

Le cavalier de mot de passe est vert pour faciliter son identification.
Pour faciliter la localisation du cavalier de mot de passe et d’autres
composants de la carte mere, consultez la carte illustrée des pi¢ces
de votre systeme. Vous pouvez télécharger cette carte illustrée a partir
du site www.hp.com/support.

5. Retirez le cavalier des broches 1 et 2. Pour éviter de le perdre,
placez-le sur la broche 1 ou sur la broche 2, mais pas sur les deux.

6. Remettez en place le capot ou le panneau d’acces de 1’ordinateur.
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7. Reconnectez I’équipement externe.

8. Branchez I’ordinateur et mettez-le en marche. Laissez le systeéme
d’exploitation démarrer. Cette opération permet d’effacer les mots
de passe existants et de désactiver les fonctions de mots de passe.

9. Pour définir de nouveaux mots de passe, répétez les étapes 1 a 4,
remettez le cavalier de mot de passe sur les broches 1 et 2, puis
répétez les étapes 6 a 8. Saisissez les nouveaux mots de passe
dans Computer Setup. Pour plus d’informations sur cet utilitaire,
consultez le Manuel de ['utilitaire Computer Setup (F10) sur le
CD Documentation.

Effacement et réinitialisation de la mémoire CMOS

La mémoire de configuration de I’ordinateur (CMOS) enregistre les
informations sur les mots de passe et sur la configuration de I’ ordinateur.

Utilisation du bouton CMOS

1. Mettez I’ ordinateur ainsi que tous ses périphériques externes hors
tension et débranchez le cordon d’alimentation de la prise secteur.

2. Déconnectez le clavier, le moniteur et tout autre équipement
externe branché sur I’ordinateur.

AVERTISSEMENT : ofin de réduire les risques de blessures consécutives
& une décharge électrique ou au contact avec des surfaces chaudes,
assurez-vous que le cordon d’alimentation est débranché et laissez les
composants refroidir avant de les toucher.

f} ATTENTION : lorsque I'appareil est branché sur le secteur, la carte
mére est toujours alimentée, méme lorsque I'unité est éteinte. Si le cordon
d’alimentation n’est pas débranché, le systéme risque d'étre endommagé.

fi ATTENTION : |"électricité statique peut endommager les composants
électroniques de I'ordinateur ou de I'équipement en option. Il est conseillé
de toucher un objet métallique relié & la terre avant de commencer l'installation.
Pour plus d’informations & ce sujet, reportez-vous au manuel Informations

sur la sécurité et les réglementations figurant sur le CD Documentation.
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3. Retirez le panneau d’acces ou capot de I’ordinateur.

ATTENTION : le fait d’appuyer sur le bouton de la CMOS réinitialisera
toutes les valeurs CMOS et effacera toutes les informations personnalisées,
telles que les mots de passe, numéros d'inventaire et réglages spéciaux. I
convient de sauvegarder les valeurs CMOS de |'ordinateur avant leur
réinitialisation, pour le cas ou elles devraient étre restaurées ultérieurement.
Cette sauvegarde s'exécute facilement & |'aide de Computer Setup.
Pour plus d’informations & ce sujet, reportez-vous au Manuel de I'utilitaire
Computer Setup (F10) sur le CD Documentation.

4. Appuyez sur le bouton CMOS et maintenez-le enfoncé pendant
environ cing secondes.

% Veillez a débrancher au préalable le cordon d’alimentation de la prise
secteur. Le bouton d’effacement de la CMOS ne fonctionne que si le
cordon d’alimentation est débranché.

Bouton CMOS

% Pour faciliter la localisation du bouton CMOS et d’autres composants
de la carte mere, consultez la Carte illustrée des pieces de votre systéme.

5. Remettez en place le capot ou le panneau d’acces de 1’ ordinateur.
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6. Rebranchez les périphériques externes.

7. Branchez 1’ ordinateur et mettez-le en marche.

%\ Lorsque la CMOS a été effacée, des messages d’erreur s’ affichent
au démarrage pendant la phase POST pour vous prévenir que la
configuration a changé. Servez-vous de I’utilitaire Computer Setup
pour réinitialiser vos mots de passe et tous les réglages systeme
spéciaux en méme temps que la date et I’heure.

Reportez-vous au Manuel de supervision des ordinateurs de bureau
pour d’autres instructions sur la redéfinition des mots de passe. Pour
plus d’informations sur Computer Setup, consultez le Manuel de
Uutilitaire Computer Setup (F10) sur le CD Documentation.

Utilisation de Computer Setup pour réinitialiser
la mémoire CMOS

Pour réinitialiser la CMOS, vous devez d’abord accéder au menu
de I'utilitaire Computer Setup.

Appuyez sur la touche F10 des que le message Computer Setup
apparait dans 1’angle inférieur droit de 1’écran. Appuyez sur Entrée
pour ignorer 1’écran de titre, si vous le souhaitez.

%\ Si vous n’appuyez pas sur la touche F10 lorsque le message s’affiche,
vous devrez éteindre I’ ordinateur, puis le remettre sous tension pour
avoir acces a I’ utilitaire.

Le menu de Computer Setup vous donne alors le choix entre cinq
options : File (Fichier), Storage (Stockage), Security (Sécurité),
Power (Alimentation) et Advanced (Avancé).

Pour rétablir les parametres d’usine par défaut de la CMOS,
commencez par définir la date et I’heure, puis utilisez les touches de
direction ou la touche Tab pour sélectionner File > Set Defaults and
Exit (Fichier > Rétablir les parametres par défaut et quitter).
Cette opération a pour effet de réinitialiser des parametres logiciels
tels que la séquence d’amorcage et d’autres réglages d’usine. En
revanche, elle ne force pas la redétection du matériel.

Reportez-vous au Manuel de supervision des ordinateurs de bureau
pour d’autres instructions sur la redéfinition des mots de passe. Pour
plus d’informations sur Computer Setup, consultez le Manuel de
Uutilitaire Computer Setup (F10) sur le CD Documentation.
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Systéme de protection d’unité (DPS)

Le systeme de protection d’unité DPS (Drive Protection System) est
un outil de diagnostic intégré aux disques durs installés sur certains
ordinateurs. Le DPS est concu pour aider au diagnostic des problemes
pouvant conduire a un remplacement du disque dur non pris en charge
par la garantie.

Lors de la construction des ordinateurs, chaque disque dur installé est
testé avec le systeme DPS et un enregistrement permanent des informations
clés est écrit sur le disque. A chaque test DPS, les résultats sont inscrits
sur le disque dur. Votre mainteneur peut ensuite utiliser ces informations
pour établir le diagnostic des pannes vous ayant conduit a exécuter
le logiciel DPS.

Le DPS n’affecte aucun programme ni données enregistrés sur le disque
dur. Le test est un microprogramme et vous pouvez I’exécuter méme
si I’ordinateur n’amorce pas le systeéme d’exploitation. Le délai
d’exécution du test dépend du fabricant et de la taille du disque dur.
En regle générale, il dure environ deux minutes par gigaoctet.

Utilisez le DPS lorsque vous suspectez un probléeme de disque dur.
Si I’ordinateur affiche le message “Détection d’une panne imminente
sur le disque dur SMART”, n’exécutez pas DPS mais faites une copie
de sauvegarde des données du disque dur et contactez un Mainteneur
Agréé pour qu’il remplace votre disque dur.
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Acces au DPS via Diagnostics for Windows

Pour accéder au DPS via I'utilitaire Diagnostics for Windows,
procédez comme suit :

1. Allumez I’ordinateur et choisissez Démarrer > Panneau
de configuration > Diagnostics for Windows.

Cinq onglets vous sont proposés sur 1’écran de diagnostics :
Présentation, Test, Statut, Journal et Erreur.

2. Cliquez sur Test > Type de test.
Un choix de trois tests apparait : Rapide, Complet et Personnalisé.
3. Sélectionnez Test personnalisé.

Vous avez le choix entre deux modes : Interactif et Sans
surveillance.

4. Sélectionnez Interactif > Unités de stockage > Disque(s) dur(s).

5. Sélectionnez la ou les unités a tester, puis Test du systeme
de protection de I’unité > Début du test.

A la fin du test, un message s’affiche (parmi trois textes possibles)
pour chaque unité testée :

B Test réussi. Code de résultat 0.
B Test interrompu. Code de résultat 1 ou 2.

B Test échoué. Remplacement de I'unité conseillé.
Code de résultat 3 a 14.

Si le test a échoué, enregistrer le code de résultat et signalez-le a votre
mainteneur pour I’aider a diagnostiquer le probleme affectant votre
ordinateur.

c-2

www.hp.com Manuel de résolution des probléemes



Systéme de protection d’unité (DPS)

Acces au DPS via l'utilitaire Computer Setup

Si votre ordinateur ne s’allume pas correctement, utilisez 1’utilitaire
Computer Setup pour accéder au programme DPS. Pour accéder au
DPS, procédez comme suit :

1. Mettez I’ordinateur sous tension ou redémarrez-le.

2. Lorsque le message F10 Setup apparait dans 1’angle inférieur
droit de votre écran, appuyez sur la touche F10.

% Si vous n’appuyez pas sur la touche F10 lorsque le message s’affiche,
vous devrez éteindre 1’ordinateur, puis le remettre sous tension pour
avoir acces a | utilitaire.

Le menu de Computer Setup vous donne alors le choix entre cing
options : File (Fichier), Storage (Stockage), Security (Sécurité),
Power (Alimentation) et Advanced (Avancé).

3. Sélectionnez Storage > DPS Self-Test.

L’écran affiche la liste des disques durs installés qui peuvent &tre
diagnostiqués par le DPS.

% Si aucun disque dur installé ne peut étre diagnostiqué, 1’option
DPS Self-Test n’apparait pas a 1’écran.

4. Sélectionnez le disque dur a tester et suivez les invites a I’écran
pour procéder au test.

A la fin du test, 1’'un des trois messages suivants s affiche :

B Test réussi. Code de résultat O.

Test interrompu. Code de résultat 1 ou 2.

Test échoué. Remplacement de 1’unité conseillé.
Code de résultat 3 a 14.

Si le test a échoué, enregistrer le code de résultat et signalez-le a votre
mainteneur pour I’aider a diagnostiquer le probleme affectant votre
ordinateur.
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Configuration de la sortie audio
analogique/numérique

Certains ordinateurs intégrent un dispositif audio raccordable a des
haut-parleurs stéréo externes analogiques ou numériques. Ces syste¢mes
peuvent détecter automatiquement le type de haut-parleur connecté
et générer le signal approprié. Pour basculer manuellement entre les
modes analogique, numérique et détection automatique, suivez la
procédure correspondant au systéme d’exploitation, telle que décrite
ci-apres.

% Si vous sélectionnez le mode de sortie numérique, le haut-parleur
interne et les haut-parleurs externes analogiques ne fonctionneront
pas tant que vous ne réglerez pas de nouveau le mode de sortie sur
analogique ou sur détection automatique. Si vous sélectionnez le
mode de sortie analogique, les haut-parleurs numériques externes
ne fonctionneront pas tant que vous ne réglerez pas de nouveau le
mode de sortie sur numérique ou sur détection automatique.

Microsoft Windows XP :

1. Cliquez sur Démarrer > Panneau de configuration, puis
double-cliquez sur Sons, Voix et Périphériques audio.

2. Sélectionnez I’onglet Matériel.
3. Sélectionnez le périphérique audio adéquat.

4. Cliquez sur Propriétés pour ouvrir le dialogue Propriétés
du périphérique.

5. Cliquez sur I’onglet Propriétés.

6. Cliquez sur le signe “+” en regard de 1’entrée “Périphériques
audio” pour développer cette branche.
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7. Cliquez sur le driver adéquat pour le sélectionner.
8. Cliquez sur Propriétés.
9. Cliquez sur Parametres.
10. Réglez le mode de sortie sur I’option de votre choix.

11. Cliquez sur le bouton OK pour fermer la boite de dialogue
Propriétés.

12. Fermez le Panneau de configuration.
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